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PREFACE  

 

Thank you very much for purchasing the Hitachi  

High-Technologies Corporation fluorescence spectrophotometer.   

 

This instrument is intended for use by persons having a 

basic knowledge of chemical analysis.  Remember that 

improper use of analytical instruments, chemicals or 

samples would result not only in wrong analytical data but 

also in consequences adverse to safety.  

 

Carefully read this instruction manual before attempting 

operation.  For proper use of the fluorescence 

spectrophotometer, please acquaint yourself with it.  

 

 

ABOUT THIS MANUAL  

 

The Hitachi High-Technologies Corporation fluorescence 

spectrophotometer is accompanied by the following two 

instruction manuals: 

 

• F-2500/F-4500 Fluorescence Spectrophotometer Instruction 

Manual - Maintenance 

• Hitachi High-Technologies Corporation Fluorescence 

Spectrophotometer Instruction Manual - FL Solutions Program 

- Operation 

 

The cautionary instructions concerning safety are contained in 

the F-2500/F-4500 Fluorescence Spectrophotometer Instruction 

Manual - Maintenance.  Be sure to read them before attempting 

operation.   

 

This instruction manual describes the operational procedures for 

the FL Solutions program formulated for the Hitachi High-

Technologies Corporation fluorescence spectrophotometer.   

Be sure to read through this instruction manual before attempting 

operation.   
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IMPORTANT  

 

Precautions on Electromagnetic Wave Interference  

 

1. Possible Electromagnetic Wave Interference Caused by 

The Instrument  

 

When the instrument is used in a residential area or an 

adjacent area thereto, it may cause interference to radio 

and television reception.  

To prevent this, use the specified system connection cables 

in strict accordance with the instruction manual.   

The instrument is designed to minimize possible 

electromagnetic wave interference caused by it if the 

specified cables are connected properly.  

However, there is no guarantee that electromagnetic wave 

interference will not be caused by the instrument.   

If the instrument does cause interference to radio or 

television reception, which can be determined by turning 

the instrument off and on, the user is encouraged to try to 

correct the interference by one or more of the following 

measures:  

• Increase separation between the instrument and the 

radio/TV receiver.  

• Connect the instrument to an outlet on a circuit different 

from that to which the radio/TV receiver is connected.  

 

2. Possible Electromagnetic Wave Interference Affecting 

the Instrument  

 

If the instrument is used near an intense electromagnetic 

source, interference noise may be given to the instrument 

to incur an adverse effect on its performance or 

functionality.  

To present this, use the specified system connection cables 

in strict accordance with the instruction manual.   

The instrument is designed to minimize possible 

electromagnetic wave interference affecting it if the 

specified cables are connected properly.   

However, there is no guarantee that electromagnetic wave 

interference will not occur in the instrument.  If the 

instrument does incur electromagnetic wave interference, 

which can be determined by turning on and off possible 

sources of electromagnetic interference nearby, the user is 

encouraged to try to correct the interference by one or more 

of the following measures:  
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• Reorient the instrument.  

• Increase separation between the instrument and 

possible sources of electromagnetic interference.  

• Increase separation between the power cable of the 

instrument and possible sources of electromagnetic 

interference.  

• Connect the instrument to an outlet on a circuit different 

from that to which possible sources of electromagnetic 

interference are connected.  

• Check that any other device connected with the 

instrument is not affected by electromagnetic 

interference.  
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WARRANTY ON PRODUCT  

 

The Hitachi fluorescence spectrophotometer is warranted to be 

free from defects in material or workmanship under normal use 

within the product specifications indicated in this manual and 

under conditions given below.  This warranty is void if the 

instrument is not used in accordance with the instruction manual.  

 

(1) Scope of Warranty  

(a) Any parts which prove to be defective in design or 

workmanship during the warranty period will be 

repaired, adjusted or replaced without charge.  

(b) A substitute part may be used for repair, or 

replacement with an equivalent product may be made 

instead of repair.  

(c) Such system components as a personal computer and 

printer to be updated frequently for improvement may 

not be available in original versions at the time of 

replacement.  

 

(2) Warranty Period  

One year from the date of initial installation  

(Excluding consumables such as a xenon lamp)  

 

(3) Availability of Technical Support Service  

Technical support service for the instrument is available 

within regular working hours on workdays predetermined by 

us.  

 

(4) Limitations and Exclusions on Warranty  

Note that the following cases are excluded from the scope 

of this warranty.  

(a) Failure due to operation at a place not meeting the 

installation requirements specified by us.  

(b) Failure due to power supply voltage/frequency other 

than specified by us or due to abnormality in power 

supply.  

(c) Corrosion or deterioration of the tubing due to 

impurities contained in reagent, gas, air or cooling 

water supplied by the user.  

(d) Corrosion of the electric circuits or deterioration of the 

optical elements due to highly corrosive atmospheric 

gas.  
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(e) Failure due to use of hardware, software or spare parts 

other than specified by us.  

(f) Failure due to improper handling or maintenance by 

the user.  

(g) Failure due to maintenance or repair by a service 

agent not approved or authorized by us.  

(h) After disposal of the instrument, or after its resale 

without our approval.  

(i) Failure due to relocation or transport after initial 

installation.  

(j) Failure due to disassembly, modification or relocation 

not approved by us.  

(k) Consumables, and failure of parts that have reached 

the end of specified useful life. 

(l) Failure of parts excluded from the warranty in the 

instruction manual or other documents.  

(m) Failure due to acts of God, including fire, earthquake, 

storm, flood, lightning, social disturbance, riot, crime, 

insurrection, war (declared or undeclared), radioactive 

pollution, contamination with harmful substances, etc.  

(n) Failure of the hardware, or damage to the system 

software, application software, data or hard disk due to 

computer virus infection.  

(o) Failure of the personal computer connected with the 

instrument, or damage to the system software, 

application software, data or hard disk due to power 

interruption or momentary power voltage drop caused 

by lightning or the like.  

(p) Failure of the personal computer connected with the 

instrument, or damage to the system software, 

application software, data or hard disk due to 

disconnection of main power to the personal computer 

without taking the specified normal shutdown 

procedure.  
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DISCLAIMER OF WARRANTY  

 

(1) WE MAKE NO WARRANTIES, EITHER EXPRESS OR 

IMPLIED, EXCEPT AS PROVIDED HEREIN, INCLUDING 

WITHOUT LIMITATION THEREOF, WARRANTIES AS TO 

MARKETABILITY, MERCHANTABILITY, FOR A 

PARTICULAR PURPOSE OR USE, OR AGAINST 

INFRINGEMENT OF ANY PATENT.  IN NO EVENT 

SHALL WE BE LIABLE FOR ANY DIRECT, INCIDENTAL 

OR CONSEQUENTIAL DAMAGES OF ANY NATURE, OR 

LOSSES OR EXPENSES RESULTING FROM ANY 

DEFECTIVE PRODUCT OR THE USE OF ANY PRODUCT.  

 

(2) NO ORAL OR WRITTEN INFORMATION OR ADVICE 

GIVEN BY US, OUR DEALERS, DISTRIBUTORS, 

AGENTS OR EMPLOYEES SHALL CREATE A 

WARRANTY OR IN ANY WAY INCREASE THE SCOPE 

OF THIS WARRANTY.  

 

 

Installation, Relocation and After-sale Technical Service  

 

Installation of the instrument shall be carried out by or under 

supervision of our qualified service personnel or our authorized 

service agent.  

Before installation of the instrument, the customer shall make 

preparations for satisfying the installation requirements in 

accordance with this manual.  

When relocation of the instrument becomes necessary after 

initial installation (delivery), please notify our local sales 

representative or service office nearest you.  

 

 

Technical Seminars and Training for Customers  

 

For the customers to acquire in-depth understanding of the 

analytical instruments, technical seminars and customer training 

courses are available at our or your site.  For further information, 

contact our local sales representative.   

(The technical seminars and customer training courses are 

available at charge.)  
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OTHER PRECAUTIONS  

 

Handling of Chemicals and Samples  

 

(1) The user is responsible for following relevant legal 

standards and regulations in the handling, storage and 

discarding of chemicals and samples used in analytical 

operations of the instrument.  

 

(2) Reagents, standard solutions and accuracy-control 

samples shall be handled, stored and discarded as 

instructed by the respective suppliers.  

 

Notice on This Instruction Manual  

 

(1) The information contained in this manual is subject to 

change without notice for product improvement.  

 

(2) This manual is copyrighted by Hitachi High-Technologies 

Corporation with all rights reserved.   

 

(3) No part of this manual may be reproduced or transmitted in 

any form or by any means without our express written 

permission.  

 

Trademark Acknowledgments  

 

Microsoft, Windows, Microsoft Excel, Microsoft Word, and 

Windows 98 are registered trademarks of Microsoft Corporation 

USA.  

All other brand names and product names used in this manual 

are trademarks, registered trademarks, or trade names of their 

respective holders.   
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PRECAUTIONS ON SAFETY 

 

Before using the Hitachi fluorescence spectrophotometer, be 

sure to read the following safety instructions carefully. 

 

 

     General Safety Guidelines 
 

• Follow all the operating procedures provided in this manual. 

• Installation and maintenance of this instrument shall be 

carried out by service personnel qualified therefore. 

• Be sure to observe the warnings indicated on the product and 

in the instruction manual.  Failure to do so could result in 

personal injury or damage to the product. 

• The hazard warnings which appear on the warning labels on 

the product or in the manual have one of the following alert 

headings consisting of an alert symbol and signal word 

DANGER, WARNING, or CAUTION. 

 

DANGER : Indicates an imminently hazardous 

situation which, if not avoided, will result 

in death or serious injury.  

(This warning does not apply to this 

product.) 

WARNING : Indicates a potentially hazardous 

situation which, if not avoided, can result 

in death or serious injury. 

CAUTION : Indicates a hazardous situation which, if 

not avoided, will or can result in minor or 

moderate injury, or serious damage to 

the product. 

 : The alert symbol shown at left precedes 

every signal word for hazard warnings, 

and appears in safety-related 

descriptions in the manual. 

 

"NOTE" and "NOTICE" are heading words which do not concern 

personal safety directly. 
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General Safety Guidelines (Continued) 
 

NOTICE : Used to indicate an instruction for preventing 

damage to the product. 

NOTE : Used to indicate an instruction for ensuring 

correct use of the product and accurate analysis 

therewith. 

 

 

• Do not modify the instrument, replace parts that are not user-

serviceable, use non-specified parts, nor remove safety 

devices, as it could be hazardous.  

• Installation at delivery, maintenance and relocation should be 

referred to service personnel qualified by us.  

• Do not perform any operation or action other than described 

in this manual.  When in doubt, please contact our local 

sales representative or service office nearest you.  

• When using a chemical for analytical operation, be sure to 

provide proper ventilation in the laboratory room as per local 

requirements.  Inadequate ventilation could endanger your 

health.  

• Keep in mind that the hazard warnings in this manual or on 

the product cannot cover every possible case, as it is 

impossible to predict and evaluate all circumstances 

beforehand.  

Be alert and use your common sense.  

 

 



 

SAFETY - 3 

     SAFETY SUMMARY 
 

 

 

 

 

 

Safety Notices on Fluorescence Spectrophotometer  
 

Electricity  

 

• Make sure that the fluorescence spectrophotometer is 

supplied with power of 100V AC, 1 kVA or more (50 Hz or  

60 Hz).  If the power voltage fluctuates or noise is applied to 

the power line, the spectrophotometer may be adversely 

affected, resulting in any trouble in it.  

• Be sure to provide grounding connection together with power 

line connection.  The grounding resistance should be 100 

ohms or less (conforming to Class-D grounding installation of 

electric facility technical standards).  Check that the 

grounding connection is proper.  If the grounding connection 

is improper, the spectrophotometer may become vulnerable to 

external noise or stray voltage may be produced in it, resulting 

in an electric shock hazard.  

• The high voltage circuit is used inside the spectrophotometer.  

To prevent electric shock, do not open covers during 

operation unless otherwise necessary.  

 

 

Source of Heat/Flame  

 

Do not smoke or hold a flame near the fluorescence 

spectrophotometer.  

 

 

Data Backup  

 

Data stored on the hard disk may become unusable due to a 

system failure, wrong operation, computer virus infection, etc.  

To ensure data integrity in case of accidental damage to the hard 

disk, periodically make backup copies of hard disk files onto 

floppy disks.  

To prevent an erroneous operation on the hard disk, always 

reserve approx. 100 MB of free space as a working area for 

application software.  
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Protection against Computer Viruses  

 

If any program/data is damaged suddenly or an unexpected 

operation/screen is encountered, the personal computer is 

suspected of being infected by a computer virus.   

Computer viruses are malicious programs that sneak into 

personal computers to cause misbehavior or damage to data.  

And, a program designed to offer protection against computer 

viruses is called a vaccine program.  

 

Possible causes of virus infection are:  

• Downloading a virus-laden program through communication.  

• Using a floppy disk or other storage medium infected by a 

virus.  

 

Note also that once any personal computer is infected by a virus, 

it may spread to other computers via communication or storage 

medium.  

Never use a program or storage medium that is suspected 

of containing a virus.  

If there is a possibility of virus infection, check for a virus using a 

vaccine program.  Note, however, that some kinds of vaccine 

programs cannot eradicate particular viruses.  So, be sure to 

make a backup of hard disk files beforehand.  

The user is requested to prepare a vaccine program and carry 

out virus removal on his or her own responsibility.  

 

 

Power Interruption  

 

On occurrence of momentary power voltage drop due to power 

interruption or lightning, the personal computer may become 

faulty or the system software, application software or data may 

be damaged.  For protection against momentary power voltage 

drop, it is advisable to use an AC uninterruptible power supply 

unit (stated according to the Japanese Electronic Industry 

Development Association guidelines for protection against 

momentary power voltage drop in personal computers).  
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Turning On/Off Personal Computer  

 

Do not turn off power to the personal computer while the hard 

disk or floppy disk drive is active.  If power to the personal 

computer is turned off while the hard disk or floppy disk is being 

accessed, the personal computer may become faulty or 

data/software stored in it may be damaged.  

Before turning off power to the personal computer, be sure to 

quit the fluorescence spectrophotometer control/data processing 

program (FL Solutions program) first and then take the shut-

down procedure using the system software.  
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FOREWORD  

 

• This instruction manual is intended for the users of the Hitachi 

fluorescence spectrophotometer.  It describes the installation, 

maintenance, operation and measurement procedures.  

• The fluorescence spectrophotometer is designed for the 

purpose of fluorescence analysis.  Never use this instrument 

for any other purposes.  

• The fluorescence spectrophotometer is intended for use by 

persons having a basic knowledge of chemical analysis.  

Other persons should use them in the presence of a person 

familiar with chemical analysis.  Remember that improper 

use of analytical instruments, chemicals or samples would 

result not only in wrong analytical data but also in 

consequences adverse to safety.  

• Before attempting installation/maintenance of the 

fluorescence spectrophotometer, read the instruction manual 

carefully and fully understand the cautionary instructions for 

the sake of safety.  

• Keep this manual handy for easy reference when necessary.  

• The information contained in this manual is subject to change 

without prior notice.  
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1.  FUNCTIONS AND SCREEN COMPOSITION  

 

 

1.1  Functions  

 

In this program, the following measurement modes are available:  

• Wavelength scan  

• Time scan  

• Photometry  

• 3-D Scan  

(‘3-D Scan program’ (option) required for Model F-2500)  

 

Wavelength Scan 

(1) Photometric value data can be printed at the specified 

wavelength intervals or at up to 12 specified wavelengths.   

 

(2) The function keys provide functions unique to the 

wavelength scan mode.  

Measurement:  [F4], Stop:  [F6]  

 

(3) Wavelength scan measurement can be repeated max. 99 

times.  And, a repetition period is settable.  

 

Time Scan 

(1) Kinetics, or rate calculation will be performed.  

 

(2) Photometric value data can be printed at the specified time 

intervals or at up to 12 specified time points. 

 

Photometry 

(1) Quantification method is selectable among specified 

wavelength, peak area, peak height, peak ratio and 

derivative methods.  Up to 20 standards can be measured.  

A calibration curve is prepared by drawing polygonal lines 

through each point of standard concentrations or a 

regression calibration curve is prepared by least square fit.  

It is also possible to measure up to 20 standards and 

prepare a calibration curve based on an average value of 

standard concentrations.   

 

(2) A calibration curve can be redrawn by re-measuring a 

specific standard.  In a calibration curve graph on the 

screen window, a value at each point can be read out 

using the cursor.  

 

1.1 



1 - 2 

(3) A calibration curve can be printed.  

A calibration curve can be drawn by inputting its factor 

value.  

 

(4) Measurement data and a calibration curve are displayed 

on the same screen window.  It is therefore possible to 

carry out measurement while observing the calibration 

curve.  

 

(5) According to the coefficient of determination calculated 

automatically, judgment can be made on a degree of 

matching between standard values and a calibration curve.   

Two/three-wavelength calculation is permitted in 

preparation of a calibration curve.  

 

(6) Statistical calculation is possible.  

Mean value of measured data and standard deviation (SD) 

can be calculated.  

 

(7) Upper/lower limit judgment will be performed.  

 

(8) Spectrum display under photometry  

In the data measured by a quatification method; peak 

height, peak area, peak ratio or derivative, a spectrum due 

to wavelength scan is displayable.  

 

3-D Scan 

(1) Spectral calculation can be performed using the measured 

data.  

 

(2) A peak table can be displayed.  

 

(3) A bird’s-eye view/synchronous spectrum can be displayed 

and printed.  

 

(4) Printing conditions are selectable.  

In use of the DDE function, the wavelength interval and 

start/end wavelengths of data list can be selected.  

 

1.1  Functions 
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Secondary Processing of Data 

Measured data can be saved, and a variety of processings can 

be carried out on the saved data.  

 

(1) Automatic reading of data (spectrum tracing)  

By placing the cursor on the currently displayed spectral 

graph, a photometric value at the cursor position can be 

read out.  

 

(2) Peak detection  

Peaks and valleys of the currently displayed spectrum are 

detected automatically.  

 

(3) Change of scale  

A measured spectrum can be enlarged or reduced by 

changing the ordinate and abscissa scales.  

 

(4) Smoothing  

A measured spectrum can be smoothed for elimination of 

noise components.  

 

(5) Derivative  

Spectral derivative is obtainable.  It is permitted to specify 

an order of derivative, that of smoothing and a count value 

of data.  

 

(6) Spectrum calculation  

Fundamental arithmetic operations can be made between 

spectra or a spectrum can be multiplied with a factor.  

 

(7) Area  

The area value of the specified peak will be calculated.  

The average area value is also calculable among peaks.  

 

(8) File conversion  

Measurement data can be converted into an ASCII text file 

(*.txt) or JCAMP-DX file (*.dx).  It is also possible to save 

a spectrum and calibration curve graph in a Windows meta 

file (*.wmf).   

 

(9) Display/print font setting  

The font, style and size of characters to be displayed and 

printed can be changed as desired.  

 

1.1 
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(10) Data acquisition  

Photometric value data on the data processing window and 

monitor window can be acquired.  Acquisition is allowed 

within 100 data.   

 

(11) Printing items collectively specifiable  

Printing items on overlaid spectra can be specified 

collectively.  

 

(12) Specification of printing items  

Items in a peak table can be selected and printed.  

 

(13) Portrait or Landscape printing settable  

Printing can be made Portrait or Landscape.   

 

(14) Collective spectrum printing  

Printing can be carried out just by specifying a file.  

 

(15) Selection of spectrum to be displayed  

The spectrum to be displayed for overlaying is selectable.  

 

(16) Automatic saving mode ON/OFF settable  

ON/OFF can be set in the sample name/comment input 

window.   

Automatic saving is effective in all the modes that use a 

sample table.  

 

(17) Data in each mode can be transferred to Microsoft Excel.  

(This is valid when Microsoft Excel 97 has been installed 

in PC.)  

 

(18) After copying spectral data into commercial software such 

as Microsoft Word, its scale, line type, color, etc. are 

changeable on the software.  

 

(19) The report generator (separately available, P/N 250-0455) 

can be used.  

 

1.1  Functions 
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1.2  Installing the FL Solutions Program  

 

For using the FL Solutions program, it must be installed using 

the attached system disks.   

Installation of the FL Solutions program is required when using it 

at the first time (not required later for each operation).  In the 

following installation session, it is assumed that: 

• The floppy disk drive is assigned as drive A. 

• The destination of installation is assigned as drive C.  

 

(1) Using the mouse, click the Start button of the Windows 98 

and select Settings - Control Panel.  The Control Panel 

window will then appear as shown in Fig. 1-1.  

 

 

Fig. 1-1 

 

 

(2) In the Control Panel window, double-click the Add/Remove 

Programs icon.  The Add/Remove Programs dialog box 

will then appear as shown in Fig. 1-2.  In this dialog box, 

click Install.  

 

 

Fig. 1-2 

1.2 
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(3) Then, when the dialog box shown in Fig. 1-3 appears, push 

in the first one of the attached system disks and click Next. 

 

 

Fig. 1-3 

 

 

(4) Then, when the dialog shown in Fig. 1-4 appears, click 

Finish.  

 

 

Fig. 1-4 

 

 

Installation process will then begin.  Take steps according 

to the instruction messages.   

1.2  Installing the FL Solutions Program 
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(5) On completion of the installation process, restart the 

personal computer.  

 

(6) For startup of the FL Solutions program, refer to 1.3.  

 

NOTES: 1. Monitor resolution must be set at 800 × 600 at 

minimum.  Otherwise, each window of the FL 

Solutions program may not be displayed fully.  

2. When the large font size of display is selected, 

words may not be indicated normally on each 

window.  In this case, font size should be changed 

to the small one.  For change, select Control 

Panel - Display Properties - Settings - Font Size.   

 

1.2 
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Reference:   

Re-installation of FL Solutions Program  

 

For re-installing this program, remove it first and then install it in 

the following procedure.  

Select Start - Settings - Control Panel.  In the Control Panel 

window, double-click the Add/Remove Programs icon, and the 

dialog box shown in Fig. 1-5 will then appear.  

 

 
 

Fig. 1-5 

 

 

In this dialog box, select “FL Solutions” and click the Add/ 

Remove button.  When it is removed, click OK.  

Thereafter, install the FL Solutions program again.   

1.2  Installing the FL Solutions Program 
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1.3  Startup of FL Solutions Program  

 

To start up the FL Solutions program, take the following 

procedure.  

 

(1) Connect the communication cable (standard accessory) 

between the fluorescence spectrophotometer and the 

personal computer.  Then, turn on power to the 

spectrophotometer and the computer in this order.   

 

(2) The Windows 98 starts.  

 

(3) Click the Start button.  Point to Programs and Hitachi 

Applications and select FL Solutions.  (See Fig. 1-6.)   

Or double-click the FL Solutions program icon.   

If the FL Solutions program is set as a startup application 

in the Windows 98, the program automatically starts when 

turning on power supply of the personal computer.   

This setting can be selected at installation of the program.   

 

 
 

 

 

Fig. 1-6 

Icon of FL Solutions program  

1.3 
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(4) The fluorescence spectrophotometer connected to the 

communication COM port of computer is now recognized 

and the window shown in Fig. 1-7 is displayed.  Then, the 

spectrophotometer is initialized.   

 

 
 

Fig. 1-7 

 

 

(5) A gauge of initialization is displayed as shown in Fig. 1-8, 

so its progress can be visually checked.  

 

 
 

Fig. 1-8 

1.3  Startup of FL Solutions Program 
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NOTE: If the spectrophotometer is not connected with 

the COM port or its power is not turned on, the 

monitor window (“F-2500 Fluorescence 

Spectrophotometer on COM1” indicated on its 

title bar) is not presented.  In this status, 

functions for other than measurement are usable.  

For measurement, first confirm connection of the 

cable, and then turn on power supply of the 

spectrophotometer.  Next, select the 

Instruments (I) command from the Tools (T) 

menu.  When selecting and connecting the 

spectrophotometer, the window shown in Fig. 1-8 

is presented. 

 

In execution of initialization, self-diagnosis is performed for 

the following items:  

• ROM 

• RAM  

• Wavelength drive system  

• Xenon lamp turn-on  

• EEPROM  

• Slit mechanism  

• Chopper  

• Backup battery voltage (only with Model F-4500)  

• Contents of wavelength and slit calibration values  

 

If an abnormality is found in the self-diagnosis, the relevant 

error message will be displayed.  In this case, a corrective 

measure should be taken, referring to 4.7 of the 

maintenance edition.   

If necessary, notify our local repair service office.  

 

 
 

Fig. 1-9 

 

 

1.3 
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(6) On completion of initialization, the window shown in  

Fig. 1-10 is displayed.  

 

 
 

Fig. 1-10 

1.3  Startup of FL Solutions Program 
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1.4  Screen Composition  

 

This manual contains multiple methods for executing a function.  

For implementing each method, explanation is given using the 

naming described below.   

 

(1) Menu bar and Command  

 

Menu bar is a bar on which menus such as “File (F)” and 

“Edit (E)” are arranged.  Commands are contained in each 

menu.   

In the case shown in Fig. 1-11, an expression of “Scan (S) 

command of Spectrophotometer (S) menu” is used.   

A menu or command is selectable by 2 methods.  

• Move the mouse pointer to a menu and click on it.  

• Key in the alphabetic letter after a menu name with the 

Alt key held down.  Then, key in the alphabetic letter 

after a command name.  

 

 
 

Fig. 1-11  Menu Bar and Command 

 

 

1.4.1 Basics of Window 

Operation 

Menu bar 
 

Command 

1.4.1 
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(2) Toolbar and Tool button  

 

Toolbar is a row of tool buttons such as     and tool 

buttons provide shortcuts for common menu commands.   

In using    , it is expressed as “     button of 

Measurement toolbar” or “     (analytical condition) 

button.”  

For details of each button, refer to 1.4.4.  

 

 

 

 
 

Fig. 1-12  Toolbar 

 

 

Toolbars 
 

1.4  Screen Composition 
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(3) Dialog box  

 

When you click the     button of Measurement toolbar, a 

small window as shown in Fig. 1-13 is presented.   

This window is called a “dialog box.”  

 

 
 

Fig. 1-13  Dialog Box 

 

 

(4) Tab  

 

Tabs are used in the Analysis Method window or Property 

window.  

Click a tab for changing display.  Each tab contains setting 

items.  The display shown in Fig. 1-14 is expressed as 

“Instrument tab.”  

 

 

 

 

Fig. 1-14 

Tabs 

1.4.1 
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(5) Spin button  

 

This button is used for inputting a numeral.  Click  

or     for setting a numeral.  However, a value below 

decimal point cannot be set.  Such a value must be input 

with the keyboard.  

 

 

Fig. 1-15  Spin Button and Combo Box 

 

 

(6) Combo box  

 

Selection is allowed among the predetermined conditions.  

Click    for selecting the desired condition.  

 

(7) Check box  

 

For turning on a check box, put a check mark in it by 

clicking.  

The check box is then set in the   status.  

For turning off the check box, click it again to remove the 

check mark.  

 

 

Fig. 1-16  Check Box 

Combo box 

Spin button 

Check box 
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The FL Solutions program have two kinds of windows; monitor 

window and data processing window.   

Set the monitor window active for measurement, or the data 

processing window for data processing.  

The toolbar differs between these windows.  

 

Fig. 1-17  Monitor Window 
 

 
 

 

Fig. 1-18  Data Processing Window 

 

 

1.4.2 Kinds of Windows 

1.4.2 
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The items displayable in each measurement mode are shown 

below.   

 

(1) Wavelength Scan  

 

A spectrum alone can be displayed or both spectrum and 

peak table can be displayed as shown in Fig. 1-19.  

Display of the peak table can be turned ON/OFF from the 

View menu.  

 

 
 

Fig. 1-19  Wavelength Scan 

 

 

(2) Time Scan  

 

A spectrum alone can be displayed or both spectrum and 

kinetics result table can be displayed as shown in Fig. 1-20.  

Display of the kinetics result table or peak table can be 

turned ON/OFF from the View menu.  

 

 

Fig. 1-20  Time Scan (kinetics) 

1.4.3 Data Processing 

Window  

Peak table 

Spectrum 

Peak table 

Spectrum   
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Fig. 1-21  Time Scan (peak table) 

 

 

(3) Photometry  

 

The items shown in Fig. 1-22 are selectively displayed 

depending on measurement method.  

 

• On measurement starting with calibration curve  

 

 
 

Fig. 1-22 

 

 

Calibration 
curve data 

Calibration 
curve 

Sample data 

Standard data 

Peak table 

Spectrum   

1.4.3 
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• On generation of calibration curve through factor input  

 

 
 

Fig. 1-23 

 

 

• On display of photometric value at each wavelength in 

multi-wavelength mode  

 

 
 

Fig. 1-24 

 

 

Calibration 
curve factor 

Sample data 

Sample data 
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The FL Solutions program provides five kinds of toolbars as 

shown below.  You can select a command by pulling down each 

menu from the menu bar.  But for quick and easy operation, it is 

advisable to use these tool buttons.   

 

• Standard Toolbar  

Has buttons related to printing and file handling.  

 

 
 

 

• Instrument Toolbar (displayed in monitor window)  

Has buttons related to spectrophotometer control such as 

wavelength drive and baseline measurement.  

 

 
 

 

• Measurement Toolbar (displayed in monitor window)  

Has buttons related to measurement such as analysis method 

setting and sample name input.   

 

 
 

 

• Spectrum Toolbar (displayed in data processing window)  

Has buttons related to spectral display such as auto scaling, 

ruled line indication and spectrum tracing.  

 

 
 

 

1.4.4 Explanation of 

Tool Buttons  

 

1.4.4 
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• Processing Toolbar (displayed in data processing window)  

Has buttons for smoothing, differentiation, etc.  

 

 
 

 

These five toolbars are independent and each of them can be 

located at a desired position as shown in Fig. 1-25 (monitor 

window).  

 

 
 

Fig. 1-25  An Example of Toolbar Arrangement 

1.4  Screen Composition 
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The following tables present the functional descriptions of the 

buttons on each toolbar.  

The function keys on the keyboard can also be utilized.  For the 

functional assignment to each function key, refer to 1.5.  

 

Table 1-1  Standard Toolbar 

 

Button Function  

 
Creates a new analysis method/sample table.  

 
Opens data files.   

 
Saves the current file.  

 
Stores a selected character string or graphic item into 
the clipboard.  

 
Pastes the contents of the clipboard.  

 
Opens the print window.  

 
Indicates the present status of the spectrophotometer 
connected.  

 
Indicates the information (version number, etc.) on the 
FL Solutions program.  

 
Calls up the help window.  

 

 

Table 1-2  Measurement Toolbar 

 

Button Function  

 
Opens the Analysis Method window.  

 

Displays the sample name/comment name entry 
window.  

 

Displays the sample table for sample name/comment 
name input.  

 

For manual input of standard sample values.   

 

Starts measurement.  

 

Stops measurement.  

 

Closes the shutter. 

 

Opens the shutter.  

 

1.4.4 
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Table 1-3  Spectrum Toolbar 

 

Button Function  

 

Restores the scale to its original condition.  

 

Indicates ruled lines.  

 
Indicates a bird’s-eye view.  

 
For display from the rear. 

 
For display from the right side.  

 
Selects a spectrum to be displayed.  

 

Indicates the trace cursor.  

 

For display in a contour map.   

 
For display from the front.  

 
For display from the left.  

 
Automatically sets the scale.  

 

 

Table 1-4  Instrument Toolbar 

 

Button Function  

 

Performs wavelength drive.  

 
Carries out automatic pre-scanning.  

 
Conducts zero-point adjustment.  

 
Enlarges the vertical-axis double.  

 

Reduces the vertical-axis to half.  

 
Restores the scale to its original condition.  

 
Adjusts the vertical-axis display automatically so that 
you can view the entire spectral graph.   

 
Indicates ruled lines.  
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Table 1-5  Processing Toolbar 

 

Button Function  

 

Opens the Spectrum Properties window.  

 

Outputs a report of data file.  

 

Performs peak detection.  

 

Performs differentiation.  

 

Performs peak detection in 3-dimensional measured 
data.  

 

Performs area calculation.  

 

Performs fundamental arithmetic calculations between 
spectra.  

 

Calculates the life of phosphorescence.  

 

Performs smoothing.  

 
Resets data.  

 

Performs fundamental arithmetic calculations of 3-
dimensional spectra.   

 

1.4.4 
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1.5  Functions of Function Keys  

 

The function keys on the keyboard provides the following 

functions.  

Each function can be directly executed.  

 

Key No. 
Wavelength 
Scan 

Time Scan Photometry 3-D Scan 

[F4] Measurement Measurement Sample measurement Measurement 

[F5]   Blank measurement   

[F6] Stop Stop Stop Stop  

[F7]   Interrupting 
measurement  

 

[F8]   Remeasurement   

[F9]   End   

 

 

1.5  Functions of Function Keys 
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1.6  Explanation of Monitor Window  

 

The monitor window contains the following information.  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Fig. 1-26  Monitor Window  

 

 

(1) Sample name indication  

 

A sample name is indicated.  For its input, use the sample 

table or sample name/comment input window.  

 

(2) Current photometric value indication  

 

The current photometric value is indicated.  

 

(3) EX  

 

The current excitation wavelength is indicated.  

 

(4) EM  

 

The current emission wavelength is indicated.  

(1) 

(2) 

(3) 

(4) 

(5) 

(6) 

(7) 

(8) 

(9) 

(10)

(11)

(12)

(13)

(14)

1.6 
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(5) EX slit  

 

The current excitation slit width is indicated.  

 

(6) EM slit  

 

The current emission slit width is indicated.  

 

(7) Shutter  

 

Shutter opening or closing is indicated.  

 

(8) Lamp  

 

ON/OFF state of the light source lamp is indicated.  

 

(9) Shutter control  

 

The active state of shutter control is indicated.  

 

(10) Corrected spectra  

 

Setting of spectrum correction is indicated.  

 

(11) Sample  

 

The number assigned to the sample under measurement is 

indicated.  

 

(12) Replicate count  

 

A count in repeated measurement is indicated.  

 

(13) Message indication  

 

An information message such as “Ready,” “Scanning” or 

“Parameter” is presented.  

When the message “Ready” is indicated, it is allowed to 

press      (measurement) button.  

 

(14) Error message indication  

 

An error message such as “Xe Lamp Error!” is presented.   

If any error message appears, take a proper 

countermeasure referring to 4.7 of the maintenance edition.   

1.6  Explanation of Monitor Window 
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Table 1-6  Possible Error Messages 

 

Message Indication  

ROM Status Error! A ROM error has occurred.  

RAM Status Error! A RAM error has occurred.  

Xe Lamp Error! The Xe lamp is not lit.  

Momentary Power 
Failure! 

Power supply of the spectrophotometer was 
cut off.  Restart the spectrophotometer for 
initialization.   

Shutter Initialize 
Error 

Shutter position cannot be detected.  

Zero Adjustment 
Error 

The spectrophotometer is abnormal.  

Auto Prescan Error Peak cannot be detected.  

Common Prescan 
Error 

Peak cannot be detected.  

EX Wavelength 
Initialize Error 

The initial position of the wavelength drive 
screw cannot be detected.  

EM Wavelength 
Initialize Error 

The initial position of the wavelength drive 
screw cannot be detected.  

Battery Voltage 
Low 

Line voltage has dropped.  

EEPROM Error An EEPROM error has occurred.  

H16 Program Error A program error of H16 has occurred.  

Chopper Error Chopper position cannot be detected.  

1.6 



1 - 30 

1.7  Input of Spectrophotometer Serial No.  

 

Select the Instruments (I) command from the Tools (T) menu or 

click the     button.  The dialog box shown in Fig. 1-27 opens.  

 

 
 

Fig. 1-27 

 

 

Click the Instrument area and then Serial Number.  The dialog 

box shown in Fig. 1-28 will open.  In this box, input the serial No. 

of your spectrophotometer.   

 

 
 

Fig. 1-28 

 

 

After input, click OK.  

The serial No. input here is saved as an analytical condition item 

into the data file and can be printed.  In connection with the  

F-4500 series (F-4500 or F-4510), the relevant 

spectrophotometer needs to be selected.  Click Instrument 

Name.  In the dialog box shown below, select the model of your 

spectrophotometer.   

 

 
 

Fig. 1-29  Instrument Name 

1.7  Input of Spectrophotometer Serial No. 
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1.8  Window Setting  

 

The information to be displayed upon starting the FL Solutions 

program or opening the data processing window can be selected 

and unnecessary one can be excluded from display.   

Select Options (O) command from the Tools (T) menu.  

In the Options dialog box, the following settings can be made.  

After your setting, click OK.   

The set functions are validated when starting the monitor window 

again or opening the data processing window.   

 

 
 

Fig. 1-30  Options Dialog Box 

 

 

This box has the following tabs.  

• Display tab 

• Fonts tab 

• Processing tab 

• Colors tab 

• Startup tab  

• Sensitivity Slits tab 

1.8 
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(1) Display Tab  

 

Items to be displayed when opening a saved data file or 

data immediately after measurement can be set here.   

Set the number of data columns to be displayed.   

The items other than the number of display columns to be 

set here can also be set by a tool button or View menu after 

measurement.  

 

 
 

Fig. 1-31  Display Tab 

 

 

(a) Trace  

Put a check mark in this box, and spectrum can be 

traced when the data processing window is open.  

 

(b) Ruled line  

The contents of monitor and data processing windows 

can be displayed with ruled lines. 

1) Wide  

2) Intermediate  

3) Narrow  

 

(c) Wavelength scan  

Items to be displayed when opening the data 

processing window in the wavelength scan mode can 

be set.  

1) Show graph only  

2) Show graph plus peak table  

1.8  Window Setting 
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(d) Time scan  

Items to be displayed when opening the data 

processing window in the time scan mode can be set.  

1) Show graph only 

2) Show graph plus kinetics data  

3) Show graph plus peak table  

 

(e) 3-dimensional (effective for Model F-2500 when the  

‘3-D Scan program’ (option) is installed) 

Items to be displayed when opening the data 

processing window in the time scan mode can be set.  

1) Show contour plus EXEM spectrum 

2) Show contour, EXEM spectrum plus peak table 

 

(f) Intracellular calcium (effective when the ‘intracellular 

calcium measurement program’ (option) is installed)  

Items to be displayed when opening the data 

processing window in the intracellular calcium mode 

can be set.  

1) Show graph only 

2) Show graph plus kinetics data 

3) Show graph plus average data  

4) Show graph plus markers  

 

(g) Intracellular calcium spectrum (effective when the 

‘intracellular calcium measurement program’ (option) is 

installed)  

Items to be displayed when opening the data 

processing window in the intracellular calcium mode 

can be set.  

1) Show fluorescence only 

2) Show fluorescence plus ratio  

3) Show fluorescence plus conc.  

4) Show fluorescence, ratio plus conc. 

 

(h) Fluorescence polarization (effective when the 

‘fluorescence polarization measurement program’ 

(option) is installed)  

Items to be displayed when opening the data 

processing window in the fluorescence polarization 

mode can be set.  

1) Show graph only  

2) Show graph plus kinetic data 

3) Show graph plus markers 

1.8 



1 - 34 

(i) Fluorescence polarization spectrum (effective when 

the ‘fluorescence polarization measurement program’ 

(option) is installed)  

Items to be displayed when opening the data 

processing window in the fluorescence polarization 

mode can be set.  

1) Show fluorescence only 

2) Show fluorescence plus polarization  

3) Show fluorescence plus anisotropy   

4) Show fluorescence, polarization plus anisotropy  

 

(2) Fonts Tab  

 

Display font, character size, etc. can be set.  

Printer font, character size, etc. are also settable.  

 

 
 

Fig. 1-32  Fonts Tab 

 

 

(a) Display Font  

Font, character size, etc. in the spectrum area under 

display can be set.  

 

1.8  Window Setting 



1 - 35 

(b) Printer Font  

Printer font is settable.  

Clicking Select (S) presents the following dialog box.  

 

 
 

Fig. 1-33  Font Specification 

 

 

Set Font, Font style and Size.  

 

(3) Processing Tab  

 

 
 

Fig. 1-34  Processing Tab 

1.8 
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(a) Area integration method  

1) Rectangular  

2) Trapezoid 

3) Romberg 

 

(b) Calibration  

A calibration curve formula to be used for the 

Photometry mode can be set.  

1) Data = f(Conc)  

2) Conc = f(Data) 

 

(c) Peak table  

Inclusion of area calculation item in the peak table can 

be selected or avoided.  

 

(d) Smooth  

The initial values of data processing function 

parameters can be set.  However, this setting will not 

be reflected on the parameters of Analysis Method 

window.  

 

(e) Derivative  

The parameters of smoothing in an analysis method or 

to be carried out after measurement can be set.  

 

(4) Colors Tab  

 

The color of the spectrum to be overlaid is settable here.  

Color 1 (bottom) is the color of the first spectrum.  

 

 

Fig. 1-35  Colors Tab 
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Click Select.  The dialog box shown in Fig. 1-36 is then 

presented.  A basic color or custom color is selectable.   

If there is no basic color you want, click Define Custom 

Colors (D).   

 

 
 

Fig. 1-36  Color Setting 

 

 

The dialog box shown in Fig. 1-37 will appear.  Select hue, 

saturation, luminance, etc. and click Add to Custom 

Colors (A).  Your color is then added to the custom colors.  

So select it and click OK.  

 

 
 

Fig. 1-37  Addition of Color 

1.8 
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(4) Startup Tab  

 

Analysis method to be taken upon startup of the FL 

Solutions program is settable here.  

 

 
 

Fig. 1-38  Startup 

 

 

(a) Restore last method used  

The method used last will be brought in.   

 

(b) Auto Parameter File 

The instrument will start with the fixed method brought 

in.  Click the model name of your instrument.  

 

 
 

Fig. 1-39 

 

 

Specify a file and click Open (O).  

1.8  Window Setting 
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1.9  Saving a Data File  

 

Data can or cannot be saved depending on setting.  So perform 

setting with reference to the following table.  Setting is any of 

patterns ① to ⑤ is recommended.  

 

Setting 
“Use sample table” 
ON/OFF 

Sample Name/Comment Input  
(“Use sample table” OFF) 

Automatic saving  ON OFF 

Analysis Method - Monitor tab 
 
“Open data processing 
window after data acquisition” 

ON OFF ON OFF ON OFF 

Display ○ ☓ ○ ☓ ○ ☓ 

Automatic saving ○ ○ ○ ○   

Result 

Manual saving     Possible Impossible

Pattern ① ② ③ ④ ⑤ ⑥ 

 

 

Read ○ and ☓ symbols in the Result - Display row as follows.  

○ : Icons or data processing window is open immediately after 

measurement.  

☓ : The data processing window is not open immediately after 

measurement.  In patterns ② and ④, data is saved.   

So the relevant data file can be opened later.  

1.9 
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1.10  Entry of File Name for Saving  

 

File name needs to be set before measurement.  Select the 

Sample Table (S) command in the Edit menu (E), and the dialog 

box shown in Fig. 1-40 will open.  Input a sample name and 

comment.  Then, bring the cursor to the file name column and 

click the button at (1).  

 

 
 

Fig. 1-40 

 

 

The dialog box shown in Fig. 1-41 will appear.  Enter your 

choice for “Save In” and specify “File Name.”  

 

 
 

Fig. 1-41 

 

(1) 
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After input, click Save.  

If the file name field remains blank, a file name such as 

default001.uds is automatically given.  

Once a measurement has been performed, you may perform the 

next ones with no change in setting (using the same sample 

table).  In this case, file names “Sample 001.uds”, “Sample 

002.uds” and so on will be given.  However, when there is no 

file name in a loaded analysis method file, file names will be 

given using the analysis method name as follows; Method .uds, 

Method 001.uds and Method 002.uds.   

Enterable number of characters  

Sample name : 20 characters 

Comment : 255 characters 

 

NOTE: If the specified storage medium (such as floppy disk or 

MO) does not have an adequate free area for new 

storage, the relevant file will be saved in the FL 

Solutions folder.  This also occurs when the specified 

folder does not have an adequate free area.  

1.10 
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1.11  Photometer Menu Commands  

 

The following commands are available in the Spectrophotometer 

menu.  

• Set Wavelength  

• Zero Adjust  

• Auto Pre-scan  

• Shutter Open/Close  

 

(1) Set Wavelength  

 

This command sets the excitation/emission wavelength to a 

specified wavelength.  

Click the Set Wavelength command or button, and the 

dialog box shown below will come up.  

 

 
 

 

(2) Auto Pre-scan  

 

This command automatically searches for an optimum 

excitation/emission wavelength for the sample under 

measurement.  Other peaks than the fluorescence peak 

(such as peaks of excitation scattered light and Raman 

spectrum) are ignored.  On completion of automatic pre-

scanning, the optimum excitation/emission wavelength is 

indicated on the monitor window (in the current wavelength 

indication field detailed in 1.6).   

 

(3) Zero Adjust  

 

This command automatically closes the shutter and 

measures a zero point in detection.  When the zero point 

is changed, e.g., after the photomultiplier voltage is 

changed, automatic zero-point adjustment is carried out.  

 

(4) Shutter Open/Close  

 

This command is available for opening/closing the 

excitation beam shutter.  The current state is indicated on 

the right side of the monitor window.   

1.11  Photometer Menu Commands 
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1.12  Utility Menu Commands  

 

The Utility menu contains the following commands: 

• Instrumental Response  

• Analog Output Gain 

• EX Power Monitor  

• Sens. Check  

• Lamp Usage  

• Lamp Off (only with Model F-2500)  

 

(1) Instrumental Response  

 

When you use this function.  You need the Spectral 

correction accessories kit (P/N 251-0126).    

 

(2) Analog Output Gain  

 

Use this command for setting a data value corresponding to 

1 V of analog output.  For details, refer to 8.4.  

 

(3) EX Power Monitor  

 

Use this command for checking output of the monitor 

detector.  When the EX Power Monitor is turned on 

(clicked), monitor value data is displayed regardless of 

measurement condition.  

 

(4) Sens. Check  

 

Use this command for checking sensitivity.  You can check 

sensitivity/drift with this command.  For details, refer to the 

maintenance edition.  

 

(5) Lamp Usage  

 

Use this command for checking/resetting the usage period 

of the xenon lamp.  A cumulative turn-on time of the xenon 

lamp is indicated.  After lamp replacement, reset this 

indication.  For details, refer to the maintenance edition.  

 

(6) Lamp Off (only with Model F-2500)  

 

Use this command for turning off the xenon lamp.  

For turning on the xenon lamp again, restarting the 

spectrophotometer is necessary.   

1.12 
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1.13  Termination of FL Solutions Program  

 

After completion of measurement, shut down the instrument in 

the following procedure.  

 

(1) From the File (F) menu, select the Exit (X) command.  

 

 
 

Fig. 1-42 

 

 

Select Yes, and the FL Solutions program will then be 

terminated.   

 

(2) Turn off the power switch of the spectrophotometer main 

unit.  

 

(3) Click the Start button of the Windows 98 and select the 

Shut Down (U) item.  In the Shut Down Windows dialog 

box, select “Shut down” and click OK.  

 

(4) Turn off power to the personal computer and the CRT 

display monitor.  

(At step (3), the personal computer may be turned off in 

some settings.)  

 

(5) Turn off power to the printer.  
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2.  WAVELENGTH SCAN  

 

 

2.1  Flow of Operation  

 

This section explains the condition setting and operating method 

for wavelength scan.   

Measurement is made in the following procedure.  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Fig. 2-1  Operational Flow (wavelength scan)  

End 

Start 

Method setting 
Click  button.  

• Scan range 

• Data mode 

• Scan speed   
 

Sample name/comment input Click  button.  

Pre-scan 

Measurement 

Data processing 

• Spectrum tracing 

• Peak detection, etc.  

Print 

(See page 2-2.) 

(See page 2-15.) 
 

(See page 2-16.)  
 

Click  button.  

(See page 2-16.)  
 

Click  button.  

(Refer to Section 6.) 

Click  button.  
(See page 2-19.)   
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2.2  Creating an Analysis Method  

 

Set the analytical conditions (method) prior to measurement.  

From the Edit menu, select the Method command or click the 

    button.  The dialog box shown in Fig. 2-2 will appear.  

 

 
 

Fig. 2-2  Analysis Method 

 

 

The following tabs are provided on the Analysis Method window 

for the wavelength scan mode.  These tabs are explained on 

the subsequent pages.   

• General 

• Instrument 

• Monitor 

• Processing 

• Report  
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(1) General  

 

The parameters shown in Fig. 2-3 are provided under the 

General tab.   

 

 
 

Fig. 2-3  General Tab 

 

 

(a) Measurement (mode)  

Select a measurement mode from among the four 

listed below.  

• Wavelength scan  

• Time scan  

• Photometry  

• 3-D Scan (displayed when the ‘3-D Scan program’ 

(option) is installed in combination with Model  

F-2500)  

 

Here, select “Wavelength scan.”  For Photometry, 

Time scan and 3-D Scan, refer to Sections 3, 4 and 5.  

 

(b) Operator  

Enter an operator name.   

 

(c) Instrument  

The model of the connected instrument is indicated.  

 

(d) Use sample table (Set measurement sample) 

Apply a check mark here when a sample table is used.   
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(e) Sampling  

• Standard  

When sample is exchanged manually.  

 

(f) Comments  

Enter a description or notes on measuring conditions.  

 

(g) Load  

Click this button to read out saved analytical conditions.  

The file opening window appears upon clicking, so 

select an analytical conditions file.  

 

(h) Save  

By clicking this button after setting the parameters for 

all five tabs, the analytical conditions are saved.  

Clicking this button overwrites parameters on the 

existing ones.   

 

(i) Save As  

Click this button for renaming the set conditions for 

saving.  The “Save As” window will appear, so enter a 

file name.   

 

(2) Instrument  

 

When you click the Instrument tab, the window in Fig. 2-4 

appears.  

 

 
 

Fig. 2-4  Instrument Tab 

2.2  Creating an Analysis Method 
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(a) Scan mode  

Select one of the following scan modes.  In case of 

Synchronous, excitation wavelength appears on the 

abscissa of the graph.   

• Excitation  

• Emission  

• Synchronous  

 

(b) Data mode  

Select one of the following data modes.  

The Luminescence mode is for measuring 

luminescence in the biological/chemical field and only 

the sample side signal is acquired without performing 

ratio photometry.  The Phosphorescence mode is for 

acquiring only phosphorescence after extinction of 

excitation beam while turning a chopper on the 

excitation side.   

• Fluorescence  

• Luminescence  

• Phosphorescence (with Model F-4500)  

 

(c) EM WL  

This is the start wavelength for wavelength scan on the 

excitation side.  Input the shorter wavelength side of 

measuring wavelength range.  

 

Model Input Range  

F-4500 200 to 900 nm or 200 to 890 nm in 
Synchronous scan mode  

F-2500 220 to 800 nm or 220 to 790 nm in 
Synchronous scan mode  

 

 

(d) EX Start WL  

This is the start wavelength for wavelength scan on the 

excitation side.  Input the shorter wavelength side of 

measuring wavelength range.  

 

Model Input Range  

F-4500 200 to 890 nm  

F-2500 220 to 790 nm  
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(e) EX End WL  

This is the end wavelength for wavelength scan on the 

excitation side.  Input the longer wavelength side of 

measuring wavelength range.  

 

Model Input Range  

F-4500 210 to 900 nm  

F-2500 230 to 800 nm  

 

 

(f) EX WL  

An excitation wavelength can be input.  It is the end 

wavelength for wavelength scan on the excitation side.  

Input the longer wavelength side of measuring 

wavelength range.   

 

Model Input Range  

F-4500 200 to 900 nm  

F-2500 220 to 800 nm  

 

 

(g) EM Start WL  

This is the start wavelength for wavelength scan on the 

emission side.  Input the shorter wavelength side of 

measuring wavelength range.   

 

Model Input Range  

F-4500 200 to 890 nm  

F-2500 220 to 790 nm  

 

 

(h) EM End WL  

This is the end wavelength for wavelength scan on the 

emission side.  Input the longer wavelength side of 

measuring wavelength range.   

 

Model Input Range  

F-4500 210 to 900 nm  

F-2500 230 to 800 nm  
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(i) Scan speed  

Set a wavelength scan speed.  (Unit:  nm/min)  

 

F-4500 F-2500  

30000 3000 

12000 1500 

2400 300 

1200 60 

300 15 

60  

15  

 

 

For the Phosphorescence data mode, select one of the 

following values.  

• 240 nm/min  

• 60 nm/min 

• 15 nm/min 

 

(j) Delay  

After pressing the Measure button, measurement is 

started following the delay time set here.  It is used for 

temperature stabilization, etc.  In repeat measurement, 

it is the time until the start of the first measurement.  

The delay time is invalid for the second and 

subsequent measurements.  

Input range:  0 to 9999 s  

 

(k) EX Slit  

Select a slit width for the excitation side.  Unit:  nm  

 

F-4500 F-2500  

1.0 2.5 

2.5 5.0 

5.0 10.0 

10.0 20.0 

20.0  
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(l) EM Slit  

Select a slit width for the emission side.  Unit:  nm  

 

F-4500 F-2500  

1.0 2.5  

2.5 5.0 

5.0 10.0 

10.0 20.0 

20.0  

 

 

(m) PMT Voltage  

A function for controlling the voltage of the 

photomultiplier detector (photomultiplier tube).   

Select one of the following values.  Changing from 

400 V to 700 V increases the data value about two 

digits and changing from 700 V to 950 V increases it 

about 1 digit.   

• 950 V (only with F-4500)  

• 700 V  

• 400 V 

 

(n) Response  

Select a response time from the following.  

 

F-4500 F-2500  

0.0004 0.04 

0.01 0.08 

0.05 0.4 

0.1 2 

0.5 8 

2.0 Auto 

8.0  

Auto  

 

 

By selecting Auto, a response time is set automatically 

according to scan speed.  Select Auto usually.  
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(o) Corrected spectra  

A function for determining the spectrum inherent to a 

sample by correcting the photometer wavelength 

characteristic using the saved instrument parameters, 

following measurement with the instrument parameters 

for photometer control.  If there are no instrument 

parameters for the wavelength range to be measured, 

only the wavelength range that allows correction is 

scanned.  And if there is no wavelength area 

measurable, an error will occur.   

For using this function, a Spectra Correction Parts Set 

(P/N 251-0126) is required.  The Instrument 

Response command is provided in the Utility menu for 

operating this function.   

When this setting is at ON, “Corrected spectra” 

appears on the monitor window.  (See Fig. 1-26 in 

1.6.)  

 

(p) Shutter control (only with F-4500)  

The shutter can be automatically closed in other than 

measurement for suppressing sample deterioration 

due to the energy of excitation beam and opened when 

measurement starts.  When you put a check mark at 

the head, the shutter will close and open at start of 

measurement.  The shutter will close again when 

measuring wavelength begins returning to the start 

wavelength after measurement in the wavelength scan 

mode.   

 

(q) Replicates  

Set the number of repeat measurements.  Input range 

is 1 to 99.  An average spectrum can also be 

determined in repeat measurement.  Setting is 

available on the Processing tab.  

 

(r) Cycle time  

Set a repetition interval.  Input range is 0.0 to  

180.0 min.  

2.2 
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(3) Monitor  

 

When selecting the Monitor tab, the window in Fig. 2-5 

appears.   

 

 
 

Fig. 2-5  Monitor Tab 

 

 

Assign the following parameters.  

 

(a) Y-Axis Max (maximum)  

Input a maximum value for Y-axis on the monitor 

window.  

 

(b) Y-Axis Min (minimum)  

Input a minimum value for Y-axis on the monitor 

window.  

 

(c) Open data processing window after data acquisition  

Select whether or not to conduct data processing after 

sample measurement.  When selected (check mark is 

applied), an icon is displayed for the data processing 

window at the end of measurement.  And by opening 

this icon, data processing such as peak detection is 

available.  
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NOTE: When the remaining memory capacity of PC 

in operation is very small (system resource 

is less than 20%), the data processing 

window will not open even if this item is 

turned ON.  Either close the presently 

opened data processing window or restart 

the FL Solutions program.   

 

(d) Print report after data acquisition  

Select whether or not to print a report after sample 

measurement.  When selected (check mark is 

applied), printing will be made automatically after 

measurement.  The items set under the Report tab 

will be printed.  When this item is not selected, data 

processing can be made by reading out a file via File - 

Open.  

 

(e) Overlay  

Spectra can be overlaid in the monitor window.   

This setting cannot be selected for repeat 

measurement.  

 

(4) Processing  

 

On selection of the Processing tab, the window in Fig. 2-6 

will be displayed.  

 

 
 

Fig. 2-6  Processing Tab 
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(a) CAT (Computing for Averaging Transient)  

Used for obtaining an average spectrum in repeat 

measurement.  This is especially effective for 

measuring samples with which the emission intensity 

varies with time.  

 

(b) Processing choices  

A list of data processing (Savitsky-Golay, Mean 

smooth, Median smooth, Derivative) is shown.   

Select a data processing item, and click the rightward-

pointing arrow key between the Processing choices 

and Processing steps display fields.  Then, the 

selected method appears in the Processing steps field.  

 

(c) Processing steps  

The processing sequence is displayed.  To delete a 

processing method, first select the method, and then 

click the leftward-pointing arrow key between the 

Processing choices and Processing steps display 

fields.  Then, the selected method disappears from 

the Processing steps field.  

Also, in case you want to carry out any smoothing in 

Processing steps, double-click the relevant item and 

the smoothing parameters (order, data points, etc.) can 

be changed.  

 

(d) Peak Finding  

Select a peak detection method indicated in the data 

processing window.  

 

(e) Threshold  

Set a detection limit for the photometric value axis of 

peak and valley.  Peaks or valleys below the setting 

will not be detected.  Input range is 0.001 to 1000.   

 

(f) Sensitivity  

Select the number of data points in the horizontal axis 

direction (abscissa).  Select a sensitivity of “1” for 

detecting sharp peaks.  Or select “8” for detecting 

broad peaks.   

• 1  

• 2 

• 4 

• 8 
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(5) Report  

 

Select the Report tab, and the window in Fig. 2-7 will 

appear.  

 

 
 

Fig. 2-7  Report Tab 

 

 

This window is used to select an output method and items 

of measurement result.   

 

(a) Output  

1) Print Report  

A report will be printed.  For printing method, 

refer to 2.6.  

2) Use Microsoft® Excel  

Data will be transferred to Microsoft® Excel.   

For transfer method, refer to 5.13.  

3) Use print generator sheet 

Select this method for using the report generator 

(option).  For usage, refer to the instruction 

manual of the report generator.  

 

(b) Orientation  

Selectable when Report is chosen for Print Method.  

Select a printing orientation.  Either Portrait or 

Landscape orientation is selectable.  When the 

Landscape orientation is selected, date and method 

can be printed.  
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(c) Printable (transferable) items  

1) Include date  

2) Include method  

3) Include graph  

4) Include data listing  

• Constant  

Data will be printed at fixed intervals between 2 

wavelength points.  Input Data interval, Start 

wavelength and End wavelength.   

• Select data 

Data at the specified wavelength will be printed.  

Up to 12 wavelengths can be specified.  

5) Include peak table 

Select output items in the peak table.  

• Peak WL/Peak data  

• Start WL/End WL  

• Valley WL/Valley data  

• Peak Area  

 

(d) Printer Font  

Click this button for changing the font to be used in the 

report.  

2.2  Creating an Analysis Method 
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2.3  Defining Your Samples  

 

When “Use Sample Table” has been set for the Analysis Method, 

the samples must be defined before measurement.  

 

(1) Open the monitor window and click the     button.  

 

(2) When the Sample Table window in Fig. 2-8 appears, fill in 

the blank section.  For instance, if there are five samples, 

click the Insert button five times.  

 

 
 

Fig. 2-8  Sample Table Window 

 

 

(3) Input the Sample, Comments and File Name for each 

sample.  The sample names input here appear on the 

monitor window also.  And the sample names input here 

are not changeable.   

Maximum number of characters to be input  

Sample : 20 characters  

Comments : 255 characters  
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(4) When input is finished, check the entries and then click the 

OK button.   

If a sample table is not used, then click the     button.  

The window in Fig. 2-9 will appear.  Make entries for 

Sample and Comment.  For automatic saving, put a check 

mark in the “Auto File” box and specify a file name for 

saving.  

 

 
 

Fig. 2-9 
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2.4  Prescan  

 

Select Pre-scan command from the Spectrophotometer menu or 

click the     (pre-scan) button.  

This function executes high-speed scan under the set measuring 

conditions, detects the peak wavelength and moves the system 

to that wavelength.  Also, the upper limit photometric value is 

automatically set so that the peak-wavelength value becomes 

approximately 70% of that upper limit value.   

Scan ranges are as follows.  

 

Excitation spectra : Start wavelength to emission 

wavelength - 20 nm or shorter 

wavelength side of end wavelength  

 

Emission spectra : Excitation wavelength or longer 

wavelength side of start wavelength + 

20 nm to end wavelength  

 

Synchronous spectra : Start wavelength to end wavelength  

 

After prescan, the upper limit photometric value is automatically 

set.   
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2.5  Conducting a Wavelength Scan  

 

(1) There are two methods of starting the scan.   

 

(a) Select the Measure command from the 

Spectrophotometer menu.  

 

(b) Click the     (measurement) button on the 

measurement toolbar.  

For halting the measurement midway, click the  

button on the toolbar.  

 

(2) Upon clicking the     button, the window shown in  

Fig. 2-10 appears when using a sample table.  Now click 

Yes.  

 

 
 

Fig. 2-10 

 

 

(3) The dialog box as in Fig. 2-11 will open.  Set each sample 

and click OK.  

 

 
 

Fig. 2-11 
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(4) When automatic saving is set, data will be saved after 

completion of measurement.  Upon opening its file, a data 

processing window will appear as in Fig. 2-12.   

Unless automatic saving is set, select the Save As 

command from the File menu and save data in file.  

 

 
 

Fig. 2-12  Data Processing Window (wavelength scan) 

 

 

(a) Spectrum  

The spectrum of a measured sample is traced.  

 

(b) Peak table  

Peak wavelength, peak height and valley wavelength 

are displayed.  

(a) Spectrum 

(b) Peak table 

2.5 
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2.6  Data Printout  

 

Printout can be provided even when the function for automatic 

printout after measurement is not used.  The following two 

procedures are available.  

 

(1) Select the Print command from the File menu.  Or click the  

     print button on the toolbar.  The field active on the 

data processing window (e.g., (a) in Fig. 2-12) will be 

printed.  What is displayed by clicking the Print Preview 

command in the File menu will be printed.   

 

 
 

Fig. 2-13 
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(2) Select the Report command in the Data menu.  Or click 

the     button on the toolbar.  The Print Preview window 

will appear, so click Print.  Select the items to be printed 

at the Report tab under Properties.  

 

 
 

Fig. 2-14 

 

 

NOTE: If characters overflow from the print frame in 

repeat measurement or in overlaying, then change 

the printing orientation from vertical to horizontal.  
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3.  TIME SCAN 

 

 

3.1  Flow of Operation  

 

This section explains the parameter setting and operating 

method for time scan.   

Measurement is performed in a flow shown below. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Fig. 3-1  Operational Flow (time scan) 

End 

Start 

Method setting 
Click  button.  

• Measuring 
wavelength 

• Scan time 
 

Sample name/comment input Click  button.  

Measurement 

Data processing 

• Rate calculation 

• Peak detection 

• Spectrum tracing 

• Spectral calculation 

Print 

(See page 3-2.) 

(See page 3-13.) 
 

(See page 3-15.)  
 

Click  button.  

(Refer to Section 6.) 

Click  button.  
(See page 3-17.)   
 

 

3.1 



3 - 2 

3.2  Creating an Analysis Method  

 

Set the analytical conditions (method) prior to measurement.  

From the Edit menu, select the Method command or click the    

button.  The dialog box shown in Fig. 3-2 will appear.  

 

 
 

Fig. 3-2  Analysis Method 

 

 

The following tabs are provided on the Analysis Method window 

for the time scan mode.  These tabs are explained on the 

subsequent pages.   

• General 

• Instrument 

• Monitor 

• Processing 

• Report  
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(1) General  

 

The parameters shown in Fig. 3-3 are provided under the 

General tab.   

 

 
 

Fig. 3-3  General Tab 

 

 

(a) Measurement (mode)  

Select a measurement mode from among the four 

listed below.  

• Wavelength scan  

• Time scan  

• Photometry  

• 3-D Scan (displayed when the ‘3-D Scan program’ 

(option) is installed in combination with Model  

F-2500)  

 

Here, select “Time scan.”  For Wavelength scan, 

Photometry and 3-D Scan, refer to Sections 2, 4 and 5.  

 

(b) Operator  

Enter an operator name.   

 

(c) Instrument  

The model of the connected instrument is indicated.  

 

(d) Use sample table (Set measurement sample) 

Apply a check mark here when a sample table is used.   
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(e) Sampling  

• Standard  

When sample is exchanged manually.  

 

(f) Comments  

Enter a description or notes on measuring conditions.  

 

(g) Load  

Click this button to read out saved analytical conditions.  

The file opening window appears upon clicking, so 

select an analytical conditions file.  

 

(h) Save  

By clicking this button after setting the parameters for 

all five tabs, the analytical conditions are saved.  

Clicking this button overwrites parameters on the 

existing ones.   

 

(i) Save As  

Click this button for renaming the set conditions for 

saving.  The “Save As” window will appear, so enter a 

file name.   

 

(2) Instrument  

 

This window appears when Time scan is specified for 

Measurement under the General tab on the Analysis 

Method window.  When you click the Instrument tab, the 

window in Fig. 3-4 appears.  

 

 
 

Fig. 3-4  Instrument Tab 
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(a) Data mode  

Select one of the following data modes.  

The Luminescence mode is for measuring 

luminescence in the biological/chemical field and only 

the sample side signal is acquired without performing 

ratio photometry.   

If phosphorescence life is shorter than 20 ms, 

“Phosphorescence short life” should be selected.   

In this case, unit time and measuring time are 

automatically set to ms and 20 ms.   

• Fluorescence  

• Luminescence  

• Phosphorescence (only with Model F-4500)  

• Phosphorescence Life Time (only with Model  

F-4500)  

• Phosphorescence Life Time (Short) (only with 

Model F-4500)  

 

(b) EX WL 

Input an excitation wavelength.  

 

Model Input Range  

F-4500 0, 200 to 900 nm 

F-2500 0, 200 to 800 nm 

 

 

(c) EM WL  

Input an emission wavelength.  

 

Model Input Range  

F-4500 0, 200 to 900 nm 

F-2500 0, 200 to 800 nm 

 

 

(d) Time unit (only with Model F-4500) 

Set a time unit.  

• s  

• ms  
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(e) Scan time  

Set a scan time.   

 

Model Input Range  

F-4500 10 to 3600 s  
1000 to 9999 ms  

F-2500 10 to 9000 s 

 

According to the set scan time, data sampling interval 

is set as listed below.  

 

• Model F-4500  

 

Measuring Time  
(s) 

Sampling Interval  
(ms) 

~ 3 1 

~ 7 2 

~ 18 5 

~ 36 10 

~ 72 20 

~ 180 50 

~ 360 100 

~ 720 200 

~ 1800 500 

~ 3600 1000 

 

In the Phosphorescence mode, the minimum sampling 

interval is 50 ms.  It is fixed at 40 µs in 

phosphorescence short-life measurement.  

 

• Model F-2500 

 

Measuring Time  
(s) 

Sampling Interval  
(ms) 

~ 120 100 

~ 240 200 

~ 600 500 

~ 1200 1000 

~ 2400 2000 

~ 6000 5000 

~ 9000 10000 
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(f) Delay  

After pressing the Measure button, measurement is 

started following the delay time set here.  It is used for 

temperature stabilization, etc.  In repeat measurement, 

it is the time until the start of the first measurement.  

The delay time is invalid for the second and 

subsequent measurements.  

Input range:  0 to 9999 s  

 

(g) EX Slit  

Select a slit width for the excitation side.  Unit:  nm  

 

F-4500 F-2500 

1.0 2.5  

2.5 5.0 

5.0 10.0 

10.0 20.0 

20.0  

 

 

(h) EM Slit  

Select a slit width for the emission side.  Unit:  nm  

 

F-4500 F-2500 

1.0 2.5  

2.5 5.0 

5.0 10.0 

10.0 20.0 

20.0  

 

 

(i) PMT Voltage  

A function for controlling the voltage of the 

photomultiplier detector (photomultiplier tube).   

Select one of the following values.  Changing from 

400 V to 700 V increases the data value about two 

digits and changing from 700 V to 950 V increases it 

about 1 digit.   

• 950 V (only with F-4500)  

• 700 V  

• 400 V 
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(j) Response  

Select a response time from the following.  

 

F-4500 F-2500 

0.04 0.04 

0.01 0.08 

0.05 0.4 

0.1 2 

0.5 8 

2.0 Auto 

8.0  

Auto  

 

 

By selecting Auto, a response time is set automatically 

according to scan speed.  Select Auto usually.  

 

(k) Shutter control (only with F-4500)  

The shutter can be automatically closed in other than 

measurement for minimizing sample deterioration due 

to the energy of excitation beam and opened when 

measurement starts.  When you put a check mark at 

the head, the shutter will close and open at start of 

measurement.  The shutter will close again when 

measuring wavelength begins returning to the start 

wavelength after measurement in the time scan mode.   

 

(l) Replicates  

Set the number of repeat measurements.  Input range 

is 1 to 99.   

 

(m) Cycle time 

Set a repetition interval.  Input range is 0.0 to  

180.0 min.   
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(3) Monitor  

 

When selecting the Monitor tab, the window in Fig. 3-5 

appears.   

 

 
 

Fig. 3-5  Monitor Tab 

 

 

Assign the following parameters.  

 

(a) Y-Axis Max (maximum)  

Input a maximum value for Y-axis on the monitor 

window.  

 

(b) Y-Axis Min (minimum)  

Input a minimum value for Y-axis on the monitor 

window.  

 

(c) X-Axis Max (maximum)  

Input a maximum value for X-axis on the monitor 

window.  

 

(d) X-Axis Min (minimum)  

Input a minimum value for X-axis on the monitor 

window.  

 

NOTE: X-Axis Max and Min correspond to a display 

interval on the monitor window.  

For example, when Max and Min are 60 and 

30, display on the window is made within 30 

to 60 s, 60 to 90 s, 90 to 120 s and so on.    
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(f) Open data processing window after data acquisition  

Select whether or not to conduct data processing after 

sample measurement.  When selected (check mark is 

applied), data is automatically saved after 

measurement.  

 

NOTE: When the remaining memory capacity of PC 

in operation is very small (system resource is 

less than 20%), the data processing window 

will not open even if this item is turned ON.  

Either close the presently opened data 

processing window or restart the FL 

Solutions program.   

 

(g) Print report after data acquisition  

Select whether or not to print a report after sample 

measurement.  When selected (check mark is 

applied), printing will be made automatically after 

measurement.  The items set under the Report tab 

will be printed.   

 

(h) Overlay  

Spectra can be overlaid in the monitor window.   

This setting cannot be selected for repeat 

measurement.   

 

(4) Processing  

 

On selection of the Processing tab, the window in Fig. 3-6 

will be displayed.  

 

 
 

Fig. 3-6  Processing Tab 
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(a) Processing choices  

A list of data processing (Savitsky-Golay smooth, 

Mean smooth, Median smooth, Derivative) is shown.   

Select a data processing item, and click the rightward-

pointing arrow key between the Processing choices 

and Processing steps display fields.  Then, the 

selected method appears in the Processing steps field.  

 

(b) Processing steps  

The processing sequence is displayed.  To delete a 

processing method, first select the method, and then 

click the leftward-pointing arrow key between the 

Processing choices and Processing steps display 

fields.  Then, the selected method disappears from 

the Processing steps field.  

Also, in case you want to carry out any smoothing in 

Processing steps, double-click the relevant item and 

the smoothing parameters (order, data points, etc.) can 

be changed.  

 

(c) Peak Finding  

Set threshold and sensitivity values for peak detection.  

 

(d) Kinetics  

Input a start time, end time and K-factor for kinetics 

(rate calculation).   
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(5) Report  

 

Select the Report tab, and the window in Fig. 3-7 will 

appear.  

 

 
 

Fig. 3-7  Report Tab 

 

 

This window is used to select an output method and items 

of measurement result.   

 

(a) Output  

1) Print Report  

A report will be printed.  For printing method, 

refer to 3.6.  

2) Use Microsoft® Excel  

Data will be transferred to Microsoft® Excel.   

For transfer method, refer to 6.13.  

3) Use print generator sheet 

Select this method for using the report generator 

(option).  For usage, refer to the instruction 

manual of the report generator.  

 

(b) Print format  

Selectable when Report is chosen for Print Method.  

Select a printing orientation.  Either Portrait or 

Landscape orientation is selectable.  When the 

Landscape orientation is selected, date and method 

can be printed.  
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(c) Printable (transferable) items  

1) Include data 

The date and time of analysis can be printed.  

Printing time will always be printed.    

2) Include method  

3) Include graph  

4) Include data listing  

• Constant  

Data will be printed at fixed intervals between 2 

wavelength points.  Input Data interval, Start 

wavelength and End wavelength.   

• Select data  

Data at the specified wavelength will be printed.  

Up to 12 wavelengths can be specified.  

5) Include peak table  

Select output items in the peak table.  

• Peak time/Peak data 

• Start time/End time 

• Valley time/Valley data 

• Peak Area  

6) Include kinetics  

 

(d) Printer Font  

Click this button for changing the font to be used in the 

report.  

3.2 



3 - 14 

3.3  Defining Your Samples  

 

When “Use Sample Table” has been set for the Analysis Method, 

the samples must be defined before measurement.  

 

(1) Open the monitor window and click the     button.  

 

(2) When the Sample Table window in Fig. 3-8 appears, fill in 

the blank section.  For instance, if there are five samples, 

click the Insert button five times.  

 

 
 

Fig. 3-8  Sample Table Window 

 

 

(3) Input the Sample, Comments and File Name for each 

sample.  The sample names input here appear on the 

monitor window also.   

Maximum number of characters to be input  

Sample : 20 characters  

Comments : 255 characters  
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(4) When input is finished, check the entries and then click the 

OK button.   

If a sample table is not used, then click the     button.  

The window in Fig. 3-9 will appear.  Make entries for 

Sample and Comment.  For automatic saving, put a check 

mark in the “Auto file saving after measurement” box and 

specify a file name for saving.  

 

 
 

Fig. 3-9 
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3.4  Conducting a Time Scan  

 

(1) There are two methods of starting the scan.   

 

(a) Select the Measure command from the 

Spectrophotometer menu.  

 

(b) Click the     (measurement) button on the 

measurement toolbar.  

 

For halting the measurement midway, click the     button 

on the toolbar.  

 

(2) Upon clicking the     button, the window shown in  

Fig. 3-10 appears when using a sample table.  Now click 

Yes.  

 

 
 

Fig. 3-10 

 

 

(3) The dialog box as in Fig. 3-11 will open.  Set each sample 

and click OK.  

 

 
 

Fig. 3-11 
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(4) When automatic saving is set, data will be saved after 

completion of measurement.  Upon opening its file, a data 

processing window will appear as in Fig. 3-12.   

Although a peak table can be displayed, simultaneous 

display of rate calculation (kinetics) result and peak table 

cannot be selected.  Fig. 3-12 shows a spectrum and the 

result of rate calculation.  This is selectable from the View 

menu.  Unless automatic saving is set, select the Save As 

command from the File menu and save data in file.  

 

 
 

 

Fig. 3-12  Data Processing Window (time scan) 

 

 

(a) Spectrum  

The spectrum of a measured sample is traced.  

 

(b) Result of rate calculation  

The results of rate calculation (gradient, activity, R, R2) 

are displayed.  Start time and end time are settable by 

numeric input or clicking Set with the line cursor 

aligned.  After setting, click Update.  For rate 

calculation, refer to APPENDIX B.   

 

(c) Peak table  

Peak wavelength, valley wavelength, peak start/end 

wavelengths and peak area are displayed.  

(a) Spectrum 

(b) Result of rate 
calculation 

3.4 



3 - 18 

3.5  Data Printout  

 

Printout can be provided even when the function for automatic 

printout after measurement is not used.  The following two 

procedures are available.  

 

(1) Select the Print command from the File menu.  Or click the  

    (print) button on the toolbar.  The field active on the 

data processing window (profiled in blue when clicked, field 

(a) in Fig. 3-12) will be printed.  The contents, that are 

displayed by selecting the Print Preview command from the 

File menu as shown in Fig. 3-13, will be printed.   

 

 
 

Fig. 3-13 
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(2) Select the Report command in the Data menu.  Or click 

the    (report) button on the toolbar.  The Print Preview 

window will appear as shown in Fig. 3-14.  Then, click 

Print.  Select the items to be printed at the Report tab 

under Properties on the Edit menu.  

 

 
 

Fig. 3-14 

 

 

NOTE: If characters overflow from the print frame in 

repeat measurement or in overlaying, then 

change the printing orientation from Portrait to 

Landscape.  

3.5 
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3.6  Calculating the Phosphorescence Life  

 

This is the function for calculating phosphorescence life from the 

measurement result (phosphorescence attenuation curve).  

Replacing data value at T1 with I0, I0/e time (T2) is found, and T1, 

T2 and τ (phosphorescence life) = T2 - T1 are displayed.  

Select the phosphorescence life command from the data (D) 

menu or click the     button on the Processing toolbar.   

A window as in Fig. 3-15 will appear.  

 

 
 

Fig. 3-15 

 

 

Move the line cursor to the start point (T1) of calculation by the 

mouse or arrow keys [←] and [→] on the keyboard.  Right-click 

the mouse at the start point.  Or input a numeral in the T1 field 

and click Calculate.  The result of calculation will be displayed.   

 

 
 

Fig. 3-16 
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For printout of the calculation result, click Print.  For printout of 

the spectrum and calculation result, apply a check mark to “With 

spectrum record” and click Print.   

For scale expansion, specify the area to be enlarged with the 

mouse.  

Draw a rectangle with the mouse button held down as shown in 

Fig. 3-17.  

 

 
 

Fig. 3-17 

 

 

When releasing the mouse button, the specified area will be 

enlarged as shown in Fig. 3-18.  

 

 
 

Fig. 3-18 

 

 

Double-clicking on the spectrum selects auto scale.  
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4.  PHOTOMETRY 

 

 

4.1  Flow of Operation 

 

This section explains the method of determining sample 

concentration with a calibration curve prepared.  Following is 

the operational flow. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Fig. 4-1  Operational Flow (photometry) 

 

 

 

End 

Start 

Method setting 
Click  button.  

• Photometric method

• Measuring 
wavelength 

• Standard table 
 

Sample name/comment input
Click  button.  

Measurement 

Measurement of standard 
and sample 

Print 

(See page 4-2.) 

(See page 4-18.) 
 

(See page 4-19.)  
 

Click  (measurement) 
button.  

Click  button.  
(See page 4-24.)   
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4.2  Creating an Analysis Method  

 

Set the analytical conditions (method) prior to measurement.  

From the Edit menu, select the Method command or click the 

button.  The dialog box shown in Fig. 4-2 will appear.  

 

 
 

Fig. 4-2  Analysis Method 

 

 

The following tabs are provided on the Analysis Method window 

for the photometry mode.  These tabs are explained on the 

subsequent pages.   

• General 

• Quantitation 

• Instrument 

• Standards 

• Monitor 

• Report  
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(1) General  

 

The parameters shown in Fig. 4-3 are provided under the 

General tab.   

 

 
 

Fig. 4-3  General Tab 

 

 

(a) Measurement (mode)  

Select a measurement mode from among the four 

listed below.   

• Wavelength scan  

• Time scan  

• Photometry  

• 3-D Scan (displayed when the ‘3-D Scan program’ 

(option) is installed in combination with Model  

F-2500)  

Here, select “Photometry.”  For Wavelength scan, 

Time scan and 3-D Scan, refer to Sections 2, 3 and 5.  

 

(b) Operator  

Enter an operator name.   

 

(c) Instrument  

The model of the connected instrument is indicated.  

 

(d) Use sample table (Set measurement sample) 

Apply a check mark here when a sample table is used.   
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(e) Sampling  

• Standard  

When sample is exchanged manually.  

 

(f) Comments  

Enter a description or notes on measuring conditions.  

 

(g) Load  

Click this button to read out saved analytical conditions.  

The file opening window appears upon clicking, so 

select an analytical conditions file.  

 

(h) Save  

By clicking this button after setting the parameters for 

all six tabs, the analytical conditions are saved.  

Clicking this button displays the “Save As” window in 

creation of a new analytical conditions file.  So input a 

file name.   

 

(i) Save As  

Click this button for renaming the set conditions for 

saving.   

 

(2) Quantitation  

 

Upon selecting the Quantitation tab, the window shown in 

Fig. 4-4 appears.  

 

 
 

Fig. 4-4  Quantitation Tab 
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(a) Quantitation type  

Select the method of creating a calibration curve.  

Wavelength, Peak area, Peak height or Derivative 

method is selectable.  

Spectra measured by the Peak area, Peak height and 

Derivative method can be checked.  

 

1) Wavelength  

Upon selecting “None” for calibration curve type in 

this quantitation method, up to 6 wavelengths can 

be set.  When any other than “None” is selected 

for quantitation type, up to 3 wavelengths can be 

set.   

(i) One wavelength calculation  

This is the most generally used method.   

As shown in Fig. 4-5 (a), one wavelength is 

specified, and the concentration is 

determined from the data I1 at that time.  

(ii) Two wavelength calculation  

As shown in Fig. 4-5 (b), assuming I1 and I2 

are the absorbance values at two different 

wavelengths, concentration is calculated 

through determination of I by the equation 

below.  

I = I2 - I1  

(iii) Three wavelength calculation  

As shown in Fig. 4-5 (c), assuming  I1, I2 and 

I3 are the data values at three different 

wavelengths, concentration is calculated 

through determination of I by the equation 

below.  Photometry is made in the order of 1, 

2, 3. 

 

I = I2 -  

 

But the following relation must hold:  

1 < 2 < 3 or 1 > 2 > 3  

1 - 3 

1 - 2 × I3 + 2 - 3 × I1 

4.2 
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Fig. 4-5  Calculation Method 

 

 

2) Peak area  

Input the peak wavelength and its accuracy.  

Measurement is made in the wavelength range 

specified at the Instrument tab.   

Peak wavelength is obtained and a calibration 

curve is prepared using the peak area of relevant 

peak.  Select an integration method among 

Rectangular, Trapezoid and Romberg.  Also set 

a threshold value and sensitivity for defining the 

peak.  

 

 
 

Fig. 4-6  Quantitation Tab (peak area) 

(c) Three wavelength 
calculation  

I = I2  - 

1 - 3 

1 - 2 × I3 + 2 - 3 × I1

WL 1 

I 

I2 

WL 2 

I1 

I3 

WL 3

(a) One wavelength 
calculation   

 
WL 1 

I 

I1 

I = I1 

(b) Two wavelength 
calculation   

WL 1

I 

I2 

WL 2 I1 

I = I2  - I1
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3) Peak height  

Input the peak wavelength and its accuracy.  

Measurement is made in the wavelength range 

specified at the Instrument tab.  Peak is 

determined within the accuracy set here and 

calculation is made in the height of that peak.   

 

 

Fig. 4-7  Quantitation Tab (peak height) 

 

 

4) Derivative  

Input a peak wavelength (or wavelength to be 

used for calibration curve preparation).  

Measurement is made in the wavelength range 

specified at the Instrument tab and a calibration 

curve is created using the derivative value at the 

peak wavelength.   

Set the derivative order, smoothing order and 

data points as derivative parameters.  

 

 

Fig. 4-8  Quantitation Tab (derivative) 
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5) Ratio  

Upon selecting Ratio, an input column for three 

factors (K0, K1, K2) and a setting column for 

calculation method (+, -, *) are displayed.  

 

NOTE: By this quantitation method, a 

calibration curve cannot be created.  

 

 
 

Fig. 4-9  Quantitation Tab (peak ratio) 

 

 

Calculation is made by the following equation.  

 

 

RATIO =  

 

 

# (calculation method):  +, -, *  

WL1, 2, 3 : Specified wavelengths  

WL3 : Background correcting wavelength  

A( ) : Measured value at specified 

wavelength  

 

(b) Calibration type  

Set a calibration type.  When selecting factor input 

(when standard calibration curve and its factors are 

already known), put a mark in the check box and enter 

values for A0, A1, A2 and A3.   

K2 (A (WL2) – A (WL3)) 

K1 (A (WL1) – A (WL3)) 
#K0 
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1) None  

Mode in which calibration curve is not used.  

When this mode is selected with Wavelength set 

for Quantification type, multi-wavelength 

measurement at up to six wavelengths is possible.  

However, no spectrum can be displayed.  

2) 1st order  

This specifies the most generally used calibration 

curve.  A linear calibration curve is to be created.  

The formula of calibration curve is as follows.  

 

x = A1y + A0  

 

Here, x is sample concentration and y is sample 

data.  

 

 

 
 

 

Fig. 4-10  1st Order 
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3) 2nd order  

A calibration curve is created using a quadratic 

curve.  The formula of calibration curve is as 

follows.  

 

x = A2y
2
 + A1y + A0  

 

Here, x is sample concentration and y is sample 

data.  

 

 
 

 

Fig. 4-11  2nd Order 
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4) 3rd order  

A calibration curve is created using a cubic curve.  

The formula of calibration curve is as follows.  

 

x = A3y
3
 + A2y

2
 + A1y + A0  

 

Here, x is sample concentration and y is sample 

data.  

 

 
 

 

Fig. 4-12  3rd Order 
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5) Segmented  

A calibration curve created by connecting 

standard samples linearly according to the 

measured values of respective samples or input 

data.  

 

 
Fig. 4-13  Segmented 

 

 

NOTE: A proper calibration curve can be 

created when the photometric value 

increases or decreases monotonously 

versus the concentration value.  With a 

monotonic increase, the calibration 

curve is created with standard 1 (STD1) 

as origin.  And with a monotonic 

decrease, the calibration curve is 

created with STD1 plotted on the 

photometric value axis and STD5 on the 

concentration axis.  In these examples, 

the number of standards is set at 5.   

Max. No. of standards:  20 
 

For the part which 
exceeds the measuring 
range, extend the line 
just before it.  
 

D
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STD 3 

STD 4

STD 5

STD 6
STD 7 
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Calibration curve with monotonous increase 

 

 

 

 
 

Calibration curve with monotonous decrease 

 

 

(c) Number of wavelengths  

When “Calibration type” is “None,” up to six 

wavelengths are selectable, and with other calibration 

types, 1 to 3 wavelengths are selectable.  

 

(d) Concentration unit  

Input a concentration (in mg/mL for example) from the 

keyboard.  

 

(e) Manual calibration  

Put a check mark in this box for creating a calibration 

curve using factors.  The number of factors (A0, A1, A2, 

A3) varies with the calibration type selected.  

 

 
 

D
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STD 1

Conc 

STD 2

STD 3

STD 4 
STD 5 

D
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STD 1

Conc 

STD 2
STD 3

STD 4

STD 5 
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(f) Force curve through zero  

By putting a check mark in this box, a calibration curve 

is created so that its factor A0 passes through “0” 

automatically.   

 

(g) Digit after decimal point  

Set the number of digits after decimal point for the 

calculated concentration of the measured sample.  

The concentration value is rounded off to the set 

number of digits.   

Input range:  0 to 3  

 

(h) Lower concentration limit/Upper concentration limit  

This is used to set a normal value range for the 

concentration of the measured sample.  If the 

concentration is higher than the upper limit set here, 

“H” will appear in the Avg Conc column, and if lower 

than the lower limit set here, “L” will appear in the Avg 

Conc column.  

 

(3) Instrument  

 

When you click the Instrument tab, the window in Fig. 4-14 

appears.   

 

 
 

Fig. 4-14  Instrument Tab 
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(a) Data mode  

Select one of the following data modes.  

The Luminescence mode is for measuring 

luminescence in the biological/chemical field and only 

the sample side signal is acquired without performing 

ratio photometry.   

• Fluorescence  

• Luminescence  

• Phosphorescence  

 

(b) Wavelength mode  

Select a wavelength for creating a calibration curve.  

• EX WL Fixed  

• EM WL Fixed  

• Both WL Fixed  

 

(c) Wavelength (1 to 6)  

Input the number of wavelengths specified at the 

Quantitation tab.   

 

Model Input Range  

F-4500 0, 200 to 900 nm  

F-2500 0, 220 to 800 nm 

 

 

(d) EX Slit  

Select a slit width for the excitation side.  Unit:  nm  

 

F-4500 F-2500  

1.0 2.5 

2.5 5.0 

5.0 10.0 

10.0 20.0 

20.0  

 

 

(e) EM Slit  

Select a slit width for the emission side.  Unit:  nm  

 

F-4500 F-2500  

1.0 2.5 

2.5 5.0 

5.0 10.0 

10.0 20.0 

20.0  
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(f) PMT Voltage  

A function for controlling the voltage of the 

photomultiplier detector (photomultiplier tube).   

Select one of the following values.  Changing from 

400 V to 700 V increases the data value about two 

digits and changing from 700 V to 950 V increases it 

about 1 digit.   

• 950 V (only with F-4500)  

• 700 V  

• 400 V 

 

(g) Auto statistic cal. number  

Calculation is made for mean value, SD (standard 

deviation) and CV (coefficient of variation).  Set the 

number of samples for this purpose.   

Input range:  2 to 4000  

 

(h) Replicates  

Set the number of measurements.   

Input range:  1 to 20  

 

(i) Integration time  

A function for obtaining data averaged over the 

specified time for the purpose of acquiring stabilized 

data.   

F-4500:  0.1 to 10.0 s  

F-2500:  1, 2, 5, 10 s 

 

(j) Delay  

After pressing the Measure button, measurement is 

started following the delay time set here.  It is used for 

temperature stabilization, etc.  In repeat measurement, 

it is the time until the start of the first measurement.  

The delay time is invalid for the second and 

subsequent measurements.  

Input range:  0 to 9999 s  
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(4) Standards  

 

Clicking the Standards tab opens the window shown in Fig. 

4-16.   

 

 
 

Fig. 4-16  Standards Tab 

 

 

(a) Sample table  

Sample table gives a list of standards for sample 

measurement or calibration curve preparation.   

This table contains the items listed below.   

 

NOTE: The size of the sample table columns (cells) 

is changeable.  Bring the cursor to a 

boundary line between left and right table 

headers, and it changes into the one shown 

below.   

 

 

Now click the mouse button on the line and 

drag it to the left or right to obtain a suitable 

column size. 

 

1) No.  

This is the number given to each sample.  

2) Sample  

Enter a sample name in up to 20 characters.  

3) Comments  

Enter comments on each sample.  

4) Concentration  

Enter a sample concentration.  

4.2 



4 - 18 

(b) Update  

By clicking this button, sample numbers are set by the 

entered number of samples.  The displayed sample 

names, comments, etc. are all cleared.  

 

(c) Insert  

When the initial screen is opened, the Insert button 

becomes active.  Click this button to insert data at the 

end of the sample list.  

 

(d) Delete  

Click the column of the sample No. to be deleted, and 

it becomes active.  Now click the Delete button and 

the item is deleted.   

 

(5) Monitor  

 

When selecting the Monitor tab, the window in Fig. 4-17 

appears.   

 

 
 

Fig. 4-17  Monitor Tab 

 

 

Assign the following parameters.  

 

(a) Y-Axis Max (maximum)  

Input a maximum value for Y-axis on the monitor 

window.  

 

(b) Y-Axis Min (minimum)  

Input a minimum value for Y-axis on the monitor 

window.  

4.2  Creating an Analysis Method 
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(c) Open data processing window after data acquisition  

Select whether or not to conduct data processing after 

sample measurement.  When selected (check mark is 

applied), the data is saved automatically after 

measurement and its file is displayed as an icon on the 

window.  And by opening this icon, data processing 

such as peak detection is available.  When this 

function is not selected, data processing can be 

achieved by reading out the file via File-Open.  

 

(d) Print report after data acquisition  

Select whether or not to print a report after sample 

measurement.  When selected (check mark is 

applied), printing will be made automatically after 

measurement.  The items set under the Report tab 

will be printed.  

 

(6) Report  

 

Select the Report tab, and the window in Fig. 4-18 will 

appear.  

 

 
 

Fig. 4-18  Report Tab 

 

 

On this window, select the items to be contained in an analysis 

report.   
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(7) Output  

 

(a) Print Report  

A report will be printed.  For printing method, refer to 

4.5.  

 

(b) Use Microsoft® Excel  

Data will be transferred to Microsoft® Excel.   

For transfer method, refer to 6.13.  

 

(c) Use print generator 

Select this method for using the report generator 

(option).  For usage, refer to the instruction manual of 

the report generator.  

 

<Printable (transferable) items>  

• Include date  

• Include method  

• Include calibration curve  

• Include standards data  

• Include calibration data  

• Include sample data  

 

(8) Printer Font  

 

Click this button for changing the font to be used in the 

report.  

4.2  Creating an Analysis Method 
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4.3  Defining Your Samples  

 

When “Use Sample Table” has been set for the Analysis Method, 

the samples must be defined before measurement.  

 

(1) Open the monitor window and select the Sample table 

command in the Edit menu or click the     button.  

 

(2) When the Sample Table window in Fig. 4-19 appears, fill in 

the blank section.  For instance, if there are five samples, 

click the Insert button five times.  Or enter “5” for Number 

of Samples and click the Update button.  

 

 
 

Fig. 4-19  Sample Table Window 

 

 

(3) Input the sample name of each sample and comments on it.  

Since sample names cannot be changed after 

measurement, input them here.  

Maximum number of characters to be input  

Sample : 20 characters  

Comments : 255 characters  

 

(4) Input the name of the data file after measurement.   

 

(5) When input is finished, check the entries and then click the 

OK button.   
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4.4  Conducting Measurement  

 

First, create a working curve, and then proceed to sample 

measurement.   

 

(1) Set the analysis method, and the window in Fig. 4-20 will 

appear provided a sample table is not used.  

 

 
 

Fig. 4-20 

 

 

When a sample table is used, the window in Fig. 4-21 will 

appear.  

 

 
 

Fig. 4-21 
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(2) There are two methods of starting measurement.   

 

(a) Select the Measure command from the 

Spectrophotometer menu.   

 

(b) Click the     (measurement) button on the 

measurement toolbar.  

 

(3) Standards will be measured.  When finished, the window 

in Fig. 4-22 will appear.  So click the OK button. 

 

 
 

Fig. 4-22 

 

 

(4) Now measure the samples.  If a sample table is not used, 

click the Sample button.  To interrupt the measurement for 

other samples, click the Interrupt button.   

The window in Fig. 4-23 will appear, so enter a sample No.  

 

 
 

Fig. 4-23 

 

 

Click the OK button and measurement starts.   

When a sample table is used, a message box is displayed, 

so conduct operation according to the messages.  

 

(5) When sample measurement is finished and a sample table 

is not used, click the End button.  From the File menu, 

select the Save As command and save the data.   

When a sample table is used, the data will be saved 

automatically.  
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(6) For conducting remeasurement after completing a series of 

measurements, click the data area to be remeasured as 

shown in Fig. 4-24 and then click the Remeasure button.   

For saving data after remeasurement, click the End button 

or     button.  The procedure is the same when a sample 

table is used.  Both standards and samples can be 

remeasured.   

 

 
 

Fig. 4-24 

 

 

(7) For conducting a blank measurement, click the Blank 

button.  

 

(8) Data is saved on completion of measurement.  When its 

file is opened, a data processing window shown in Fig. 4-25 

appears.   

 

 

 
 

 

Fig. 4-25  Data Processing Window (photometry) 

(a) Standard data  

(b) Calibration curve  

(d) Calibration curve data  

(c) Sample data  

4.4  Conducting Measurement 
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(a) Standard data  

The measurement results of standards used for 

preparing a calibration curve are displayed.  

 

 
 

Fig. 4-25-1  Standard Data 

 

 

(b) Calibration curve  

A calibration curve obtained from standard data is 

displayed.  The curve can also be traced.  

Concentration and photometric value are indicated at 

the top left of this field.  

 

(c) Sample data  

Sample data such as photometric value (Abs), 

concentration (Conc), mean value (Avg Conc), 

standard deviation (SD), coefficient of variation (CV) 

and upper/lower limit judgment results (HIGH/LOW) 

are displayed.  

 

 
 

Fig. 4-25-2  Sample Data 

 

 

4.4 
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(d) Calibration curve data  

Data such as determination coefficient and factors (A0, 

A1, A2, A3) of calibration curve are displayed.  And the 

calibration type can be changed.  

 

 
 

Fig. 4-25-3  Calibration Curve Data 

 

 

The standard data can be input manually.  This function is 

usable after measurement of standards.  Either select Standard 

from the Edit menu of monitor window or click the     button.  

A window as in Fig. 4-26 will appear.  So enter values in the 

Data column.  After entry, click the OK or Update button.  

Then, the calibration curve is recalculated and displayed.  

 

 
 

 

Fig. 4-26 

4.4.1 Manual Input of 

Standard Data  

 
 

4.4  Conducting Measurement 
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Statistical calculation is performed for the measured sample.  

The results are displayed in the “Avg Conc” column of the data 

processing window as shown in Fig. 4-25-2.   

 

 

MEAN =  

 

 

CV =         × 100 
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Here, N = number of standards  

MEAN = mean value  

SD = standard deviation  

CV = coefficient of variation (%)  

 

NOTE: “*****” is indicated for SD and CV values when they are 

nearly “0.”  

4.4.2 Statistical 

Calculation 

 

N 

ΣXi 

MEAN

SD 

4.4.2 



4 - 28 

4.5  Printing Data  

 

Printout can be provided even when the function for automatic 

printout after measurement is not used.  The following two 

procedures are available.  

 

(1) Select the Print command from the File menu.  Or click the  

    print button on the toolbar.  The field active on the 

data processing window (e.g., (b) in Fig. 4-25) will be 

printed.  What is displayed by clicking the Print Preview 

command in the File menu will be printed.   

 

 
 

Fig. 4-27 

 

 

4.5  Printing Data 
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(2) Select the Report command in the Data menu.  Or click 

the     button on the toolbar.  The Print Preview window 

will appear.  So click the Print button.  Select the items to 

be printed at the Report tab with the Properties command 

chosen in the Edit menu.  The measuring parameters will 

also be printed.  

 

 
 

Fig. 4-28 

4.5 
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4.6  Remeasuring Standard Data and Sample Data  

 

Standard data and sample data can be remeasured at the mid-

point of a series of measurements or after it.   

For remeasurement, implement the following procedure.  

 

(1) Open the monitor window after completion of measurement.  

 

(2) Click the data to be remeasured.  

 

 
 

Fig. 4-37 

 

 

(3) Click Remeasure or select the Remeasure (E) command 

from the Spectrophotometer (S) menu.  The dialog box in 

Fig. 4-38 will open.   

 

 
 

Fig. 4-38 

 

 

(4) Click OK, and measurement will start.  When a standard is 

remeasured, the calibration curve will be recalculated and 

displayed.  

 

(5) Click the     button, and the data will be saved.  

4.6  Remeasuring Standard Data and Sample Data 
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4.7  Manual Input of Standard Data  

 

The standard data can be input manually.  This function is 

usable after measurement of standards.  Either select Standard 

(T) from the Edit menu of monitor window or click the     button.  

A window as in Fig. 4-39 will appear.  So enter values in the 

Data column.  After entry, click the OK or Update button.  

Then, the calibration curve is recalculated and displayed.  

 

 
 

Fig. 4-39 

 

 

4.7 
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4.8  Measurement Using Saved Calibration Curve  

 

Call a calibration curve in the following way.  

 

(1) Set measurement mode in Photometry.  

 

(2) From the File (F) menu, select the calibration curve load 

command.  A window as shown below will appear.   

Select the file of the calibration curve to be used.  

 

 
 

Fig. 4-40 

 

 

(3) When selecting the file, the window as shown in Fig. 4-41 

will appear.  The sample data section is blank.  

 

 
 

Fig. 4-41 

 

 

4.8  Measurement Using Saved Calibration Curve 



4 - 33 

(4) Edit a sample table.  

 

(5) Set a blank sample to carry out auto zero.  

From the Spectrophotometer (S) menu, select the Auto 

zero (Z) command.  Or click the     button.  

 

(6) From the Spectrophotometer (S) menu, select Scan (S) 

command.  Or click the     button on the toolbar. 

 

(7) Set and measure a sample.  

 

 

4.8 
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5.  3-D SCAN 

 

 

5.1  Flow of Operation 

 

This section explains the parameter setting and operating 

method for 3-D Scan.  

For using the 3-D Scan mode in the Model F-2500, the optional 

‘3-D Scan program’ needs to be installed.  

Measurement is made in the following procedure. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Fig. 5-1  Operational Flow (3-D Scan) 

End 

Start 

Method setting Click  button.  

• Scan range 

• Data mode 

• Scan speed 
 

Sample name/comment input Click  button.  
 

Measurement 

Data processing • Spectrum tracing 

• Peak detection 

• Spectral calculation 

Print 

(See page 5-2.) 

(See page 5-13.) 
 

(See page 5-14.)  
 

Click  button.  

(Refer to Section 6.) 

Click  button.  
(See page 5-17.)   
 

Pre-scan 

(See page 5-14.)  
 

Click  button.  
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5.2  Creating an Analysis Method  

 

Set the analytical conditions (method) prior to measurement.   

 

(1) From the Edit menu, select the Method command or click 

the     button.  The dialog box shown in Fig. 5-2 will 

appear.  

 

 
 

Fig. 5-2  Analysis Method 

 

 

(2) Set the analysis method on this window.  For details of 

each tab, refer to 5.1.2 onward.   

The following tabs are provided on the Analysis Method 

window for the 3-D Scan mode.   

These tabs are explained on the subsequent pages.   

• General 

• Instrument 

• Monitor 

• Processing 

• Report  
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(3) General  

 

The parameters shown in Fig. 5-3 are provided under the 

General tab.   

 

 
 

Fig. 5-3  General Tab 

 

 

(a) Measurement (mode)  

Select a measurement mode from among the four 

listed below.  

• Wavelength scan  

• Time scan  

• Photometry  

• 3-D Scan  

Here, select “3-D Scan.”  For Wavelength scan, time 

scan and Photometry, refer to Sections 2, 3 and 4.  

 

(b) Operator  

Enter an operator name.   

 

(c) Instrument  

The model of the connected instrument is indicated.  

 

(d) Sampling 

• Standard  

When sample is exchanged manually.  

 

(e) Comments  

Enter a description or notes on measuring conditions.  

 

5.2 
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(f) Load  

Click this button to read out saved analytical conditions.  

The file opening window appears upon clicking, so 

select an analytical conditions file.  

 

(g) Save  

By clicking this button after setting the parameters for 

all five tabs, the analytical conditions are saved.  

Clicking this button overwrites parameters on the 

existing ones.   

 

(h) Save As  

Click this button for renaming the set conditions for 

saving.  The “Save As” window will appear, so enter a 

file name.   

 

(4) Instrument  

 

This window appears when 3-D Scan is selected for the 

Measurement under the General tab of the Analysis 

Method window.  When you click the Instrument tab, the 

window in Fig. 5-4 appears.  

 

 
 

Fig. 5-4  Instrument Tab 

5.2  Creating an Analysis Method 
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(a) Data mode  

Select either of the following data modes.  

The Phosphorescence mode is for acquiring only 

phosphorescence after extinction of excitation beam 

while turning a chopper on the excitation side.   

• Fluorescence  

• Phosphorescence (with Model F-4500)  

 

(b) EX Start WL  

This is the start wavelength for wavelength scan on the 

excitation side.  Input the shorter wavelength side of 

measuring wavelength range.  

 

Model Input Range  

F-4500 0, 200 to 850 nm 

F-2500 0, 200 to 750 nm 

 

 

(c) EX End WL  

This is the end wavelength for wavelength scan on the 

excitation side.  Input the longer wavelength side of 

measuring wavelength range.  

 

Model Input Range  

F-4500 0, 200 to 900 nm 

F-2500 0, 200 to 800 nm 

 

 

(d) EX Sampling interval  

In the 3-dimensional measurement mode, emission 

spectrum measurement is repeated while shifting the 

excitation wavelength.  Therefore, a shorter sampling 

interval on the excitation side will result in a longer 

measurement time.  

Input range:  1 to 50 nm  

 

(e) EM Start WL  

This is the start wavelength for wavelength scan on the 

emission side.  Input the shorter wavelength side of 

measuring wavelength range.   

 

Model Input Range  

F-4500 0, 200 to 850 nm 

F-2500 0, 200 to 750 nm 

 

5.2 
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(f) EM End WL  

This is the end wavelength for wavelength scan on the 

emission side.  Input the longer wavelength side of 

measuring wavelength range.   

 

Model Input Range  

F-4500 0, 200 to 900 nm 

F-2500 0, 200 to 800 nm 
 

 

 

(g) EM Sampling interval  

In the 3-D Scan mode, emission spectrum 

measurement is repeated while shifting the excitation 

wavelength.  Therefore, a shorter sampling interval on 

the emission side will result in a longer measurement 

time.  

Input range:  1 to 10 nm  

 

(h) Scan speed  

Set a scan speed.  (Unit:  nm/min)  

 

F-4500 F-2500 

30000 3000 

12000 1500 

2400 300 

1200 60 

300 15 

60  

15  

 

 

(i) EX Slit  

Select a slit width for the excitation side.  Unit:  nm  

 

F-4500 F-2500 

1.0 2.5 

2.5 5.0 

5.0 10.0 

10.0 20.0 

20.0  
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(j) EM Slit  

Select a slit width for the emission side.  Unit:  nm  

 

F-4500 F-2500 

1.0 2.5 

2.5 5.0 

5.0 10.0 

10.0 20.0 

20.0  

 

 

(k) PMT Voltage  

A function for controlling the voltage of the 

photomultiplier detector (photomultiplier tube).   

Select one of the following values.  Changing from 

400 V to 700 V increases the data value about two 

digits.   

• 950 V (only with F-4500)  

• 700 V  

• 400 V 

 

(l) Response  

Select a response time from the following.  

 

F-4500 F-2500 

0.04 0.04 

0.01 0.08 

0.05 0.4 

0.1 2 

0.5 8 

2.0 Auto 

8.0  

Auto  

 

 

By selecting Auto, a response time is set automatically 

according to scan speed.  Select Auto usually.  

 

5.2 
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(m) Corrected spectra  

A function for determining the spectrum inherent to a 

sample by correcting the photometer wavelength 

characteristic using the saved instrument parameters, 

following measurement with the instrument parameters 

for photometer control.  If there are no instrument 

parameters for the wavelength range to be measured, 

only the wavelength range that allows correction is 

scanned.  And if there is no wavelength area 

measurable, an error will occur.   

For using this function, a Spectra Correction Parts Set 

(P/N 251-0126) is required.  The Instrument 

Response command is provided in the Utility menu for 

operating this function.  When this setting is at ON, 

“Corrected spectra” appears on the monitor window.  

(See Fig. 1-26 in 1.6.)  

 

(n) Shutter control (only with F-4500)  

The shutter can be automatically closed in other than 

measurement for suppressing sample deterioration 

due to the energy of excitation beam and opened when 

measurement starts.  When you put a check mark at 

the head, the shutter will close and open at start of 

measurement.  The shutter will close again when 

measuring wavelength begins returning to the start 

wavelength after measurement in the wavelength scan 

mode.   

 

5.2  Creating an Analysis Method 
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(5) Monitor  

 

When selecting the Monitor tab, the window in Fig. 5-5 

appears.   

 

 
 

Fig. 5-5  Monitor Tab 

 

Assign the following parameters.  

 

(a) Y-Axis Max (maximum)  

Input a maximum value for Y-axis on the monitor 

window.  

 

(b) Y-Axis Min (minimum)  

Input a minimum value for Y-axis on the monitor 

window.  

 

(c) Contour interval  

Function for setting intervals of drawing contour lines.  

Input range:  0.01 to 1000  

 

(d) Open data processing window after data acquisition  

Select whether or not to conduct data processing after 

sample measurement.  When selected (check mark is 

applied), an icon is displayed for the data processing 

window at the end of measurement.  And by opening 

this icon, data processing such as peak detection is 

available.  

 

5.2 
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NOTE: When the remaining memory capacity of PC 

in operation is very small (system resource is 

less than 20%), the data processing window 

will not open even if this item is turned ON.  

Either close the presently opened data 

processing window or restart the FL 

Solutions program.   

 

(e) Print report after data acquisition  

Select whether or not to print a report after sample 

measurement.  When selected (check mark is 

applied), printing will be made automatically after 

measurement.  The items set under the Report tab 

will be printed.  When this item is not selected, data 

processing can be made by reading out a file via File-

Open.  

 

(6) Processing  

 

On selection of the Processing tab, the window in Fig. 5-6 

will be displayed.  

 

 
 

Fig. 5-6  Processing Tab 

 

 

(a) Peak Finding  

Select a peak detection method indicated in the data 

processing window.  
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(b) Threshold  

Set a detection limit for the photometric value axis of 

peak and valley.  Peaks or valleys below the setting 

will not be detected.  Input range is 0.001 to 1000.   

 

(c) Sensitivity  

Select the number of data points in the horizontal axis 

direction (abscissa).  Select a sensitivity of “1” for 

detecting sharp peaks.  Or select “8” for detecting 

broad peaks.   

• 1  

• 2 

• 4 

• 8 

 

(7) Report  

 

Select the Report tab, and the window in Fig. 5-7 will 

appear.  

 

 
 

Fig. 5-7  Report Tab 

 

 

(8) Output 

 

(a) Print Report  

A report will be printed.  For printing method, refer to 

5.7.  

 

(b) Use Microsoft® Excel  

Data will be transferred to Microsoft® Excel.   

For transfer method, refer to 6.13.  

5.2 
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(c) Use print generator sheet  

Select this method for using the report generator 

(option).  For usage, refer to the instruction manual of 

the report generator.  

 

(9) Orientation  

Selectable when Report is chosen for Print Method.  

Select a printing orientation.  Either Portrait or Landscape 

orientation is selectable.  When the Landscape orientation 

is selected, date and method can be printed.  

 

(a) Printable (transferable) items  

1) Include date  

2) Include instrument 

3) Include graph  

• Contour  

• Bird’s-eye view  

• Contour and bird’s-eye view 

• Contour and Spectrum  

4) Include peak table  

 

(b) Printer Font  

Click this button for changing the font to be used in the 

report.  

5.2  Creating an Analysis Method 
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5.3  Defining Your Samples  

 

Samples must be defined before measurement.  

Click the     button.  The dialog box in Fig. 5-8 will appear.   

 

 
 

Fig. 5-8 

 

 

Input for Sample and Comments.  For automatic saving, put a 

check mark in the “Auto File” box and specify a file name.   

To specify a file name, click Select.  

5.3 
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5.4  Conducting Measurement  

 

(1) There are two methods of starting the measurement.   

 

(a) Select the Measure command from the 

Spectrophotometer menu.  

 

(b) Click the     (measurement) button on the 

measurement toolbar.  

For halting the measurement midway, click the  

button on the toolbar.  

 

(2) When automatic saving is set, data will be saved after 

completion of measurement.  Unless automatic saving is 

set, select the Save As command from the File menu and 

save data in file.  Upon opening its file, a data processing 

window will appear as in Fig. 5-9.  

 

 

 

 
 

 

 

Fig. 5-9  Data Processing Window (3-D Scan) 

 

 

(a) Contour lines  

From these contour lines, excitation and emission 

spectra can be read out.   

As the cursor is moved, the cursor-specified excitation 

and emission spectra are displayed in (b) and (c).    

 

(a) Contour lines  

(b) Excitation spectrum   (d) Peak table  

(c) Emission spectrum  

5.4  Conducting Measurement 
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(b) Excitation spectrum  

An excitation spectrum at the cursor position in (a) is 

displayed.  Wavelength and photometric value can be 

read by selecting the trace command from the View 

menu or clicking the     button.   

 

(c) Emission spectrum  

An emission spectrum at the cursor position in (a) is 

displayed.  Wavelength and photometric value can be 

read by selecting the trace command from the View 

menu or clicking the     button.   

 

(d) Peak table  

Peak wavelength and peak height are indicated.   

For setting threshold and sensitivity values, click the  

     button.   

 

 

5.4 
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5.5  Displaying a Bird’s-Eye View  

 

3-D Scan data can be displayed in a bird’s-eye view.   

Select the Bird’s-eye view command from the View menu or click 

the     (bird’s-eye view) button on the Spectrum toolbar.  

 

 
 

Fig. 5-10 

 

 

Viewing direction is changeable by clicking     (from front),  

    (from rear),     (from left) or     (from right).   

Clicking     (contour line diagram) displays a contour line 

diagram.   

 

 

5.5  Displaying a Bird’s-Eye View 
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5.6  Data Printout  

 

Printout can be provided even when the function for automatic 

printout after measurement is not used.  The following two 

procedures are available.  

 

(1) Select the Print command from the File menu.  Or click the  

    print button on the toolbar.  The field active on the 

data processing window (e.g., (a) in Fig. 5-9) will be printed.   

The contents of display upon clicking the Print Preview 

command in the File menu will be printed.  

 

 
 

Fig. 5-11 

 

 

 

5.6 
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(2) Select the Report command in the Data menu.  Or click 

the     button on the toolbar.  The Print Preview window 

will appear, so click Print.  Select the items to be printed 

at the Report tab under Properties.  

 

 
 

Fig. 5-12 

5.6  Data Printout 
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6.  DATA PROCESSING  

 

 

This section explains the operation method for data processing 

after measurement.  

 

6.1  Loading of Data  

 

Load saved data as follows.   

Either click the     (Open) button or select the Open command 

from the File menu.  A window as in Fig. 6-1 will appear.   

 

 
 

Fig. 6-1 

 

 

Select the file type of data file in “Files of type” where file types 

are listed.  Specify a desired file and click Open, and the data 

file will open.   

The following types are included in “Files of type.” 

• Wavelength scan files (*.fds)  

• Time scan files (*.fdt) 

• Photometry files (*.fdq)  

• 3-D Scan files (*.fd3)  

• Method files (*.flm)  

• Sample table files (*.fls)  

• Report files (*.flr)  

6.1 
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• Processed data files (*.fdp)  

• F-4500 wavelength scan files (*.fds) 

• F-4500 time scan files (*.fdt)  

• F-4500 photometry files (*.fdq)  

• F-4500 3-D Scan files (*.fcd)  

• All files (*.*)  

 

The window (Fig. 6-1) has four tool buttons.  Table 6-1 lists the 

tool buttons and their functions.  

 

Table 6-1  File-Open Window Buttons 

 

Button Function  

 

Displays a folder of one level higher.   

 
Creates a new folder.  

 

Lists the file names included in selected 
folder.  

 
Displays file details such as file name, 
size and type.  

 

 

NOTE: When the remaining memory capacity of PC in 

operation is very small (system resource is less than 

20%), the data processing window will not open.  

Either close the presently opened data processing 

window or restart the FL Solutions program.  

6.1  Loading of Data 
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6.2  Spectrum Tracing  

 

This function is used to read the photometric value at a certain 

wavelength on the measured spectrum.  First, bring the cursor 

onto the displayed spectrum, then right-click the mouse and a 

window as in Fig. 6-2 appears.  

 

 
 

Fig. 6-2 

 

 

Put a check mark before Trace or click the     button.  A line 

cursor appears on the spectrum.  The wavelength and 

photometric value at the cursor position are indicated at the 

location (a) in Fig. 6-3.   

 

 
 

Fig. 6-3 

 

 

(a) 

 

6.2 
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The line cursor can be moved in the following two ways.  

 

(1) Movement using mouse  

 

Move the line cursor with the mouse to the position for 

readout.  

 

(2) Movement using arrow keys on the keyboard  

 

Click the [→] or [←] key and the line cursor moves in the 

corresponding direction.  

6.2  Spectrum Tracing 
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6.3  Scale Change  

 

The X and Y-axis scales of data can be changed.  

Click the     (properties) button and select the Scale tab.   

Or right-click on the spectrum and select “Scale change.”  

 

 
 

Fig. 6-4  Scale Tab 

 

 

Enter values in the Maximum and Minimum columns for the X 

and Y axes.  The initial values are those that have been saved.  

The above window contains the following setting items.  

 

(1) X Axis  

Enter minimum and maximum values for the X axis.  

 

(2) Y Axis  

Enter minimum and maximum values for the Y axis.  

 

(3) Default Range  

System returns to initial values of X and Y axes.   

 

Scale can be expanded with the mouse.  Specify an area to be 

expanded.  Holding the mouse button held down, draw a 

rectangle, and then release the button.  Scale will be expanded.  

For returning to the original scale, click the Default Range button 

or the     button on the toolbar.  

6.3 
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6.4  Change of Graph Axis  

 

The horizontal axis of a graph is changeable on a spectrum.  

Click the     (properties) button and select the Scale tab.   

 

 
 

Fig. 6-5  Scale Tab 

 

 

(1) X Axis mode  

 

X-axis is indicated in either unit below. 

 

(a) nm  

Indicated in wavelength (nm). 

 

(b) Kcm-1  

Indicated in wavenumber (Kcm-1, K = 1000).  

x・λ = 10000 (x:  Kcm-1, λ:  nm)  

6.4  Change of Graph Axis 
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6.5  Change of Spectral Line  

 

The line and color of a spectrum can be changed.  Select the 

Lines/Points tab of Spectrum Properties.  Upon clicking this tab, 

the window below appears.  

 

 
 

Fig. 6-6  Lines/Points Tab 

 

 

The following setting items are contained in this window.  

 

(1) Graph  

 

Select a spectrum for setting lines/points.  

 

(2) Display mode  

 

Data can be indicated in the following modes.  

• Lines 

• Points  

• Lines & Points  

 

(3) Line pattern  

 

Specify the kind of line such as dotted line or solid line.   

 

(4) Point style  

 

Select the point style to be used in graph printing or display.  

 

6.5 
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(5) Line color  

 

Use of the Color window enables you to change the color of 

spectral lines or points.  There are 48 basic colors.   

By clicking the Define Custom Colors button, a smaller 

window is added on the right side of the Color window as 

shown in Fig. 6-7.  And by clicking Define Custom Colors 

again, 16 colors are added.  These colors are usable or 

the spectral lines and points.  For defining the colors, 

entries can be made for Hue, Sat (saturation) and Lum 

(luminance), Red, Green and Blue.  When the definition is 

finished, click the Add to Custom Colors button.  Then, 

select the desired ones from the defined colors.  

 

 
 

Fig. 6-7 

6.5  Change of Spectral Line 
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6.6  Detection of Spectral Peaks  

 

The spectral peaks and valleys are detectable automatically.  

Select the Find Peaks command from the Data menu or click  

     button, and a window as in Fig. 6-8 appears.   

Set Integration method, Threshold and Sensitivity.  

 

 
 

Fig. 6-8 

 

 

(1) Integration method  

 

The following three methods are available and any one may 

be selected for the peak wavelength.  But the area 

calculation result indicated in the peak table will vary with 

the selected method.  

• Rectangular  

• Trapezoid 

• Romberg 

 

For details of these methods, refer to APPENDIX D.   

 

(2) Threshold  

 

Set a detection limit for the photometric value axis of peaks 

and valleys.  Peaks and valleys below the set value will 

not be detected.  

Input range:  0.001 to 1000  

 

(3) Sensitivity  

 

Select the number of data points in X axis direction.   

For detection of sharp peaks, select a sensitivity level of 

“1,” and for broad peaks, select “8.”  

• 1  

• 2 

• 4 

• 8 
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6.7  Indication of Peak Wavelength on Spectrum  

 

Select the Properties (O) command from the Edit (E) menu or 

click the     (properties) button on the Processing toolbar.   

The window in Fig. 6-9 will open.   

 

 
 

Fig. 6-9  Display Tab 

 

 

In the Comments under this tab, the following settings can be 

made.  

 

(1) None  

 

Only a spectrum is displayed.  

 

(2) Peak Number  

 

Peak No. is indicated on a spectrum.  This number is the 

one indicated in the peak table.  

 

(3) Peak Apex  

 

Peak wavelength is indicated on a spectrum.   

This wavelength is the one indicated in the peak table.   

It appears as shown in Fig. 5-9 and can be printed.  

 

(4) Valley No.  

 

Valley No. is indicated on a spectrum.  This number is the 

one indicated in the peak table.  

6.7  Indication of Peak Wavelength on Spectrum 
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(5) Valley wavelength  

 

Valley wavelength is indicated on a spectrum.   

This wavelength is the one indicated in the peak table.   

It can be printed.  

 

(6) Peak and Valley Number  

 

Peak and valley Nos. are indicated on a spectrum.   

These numbers are the ones indicated in the peak table.  

 

(7) Peak and valley wavelength  

 

Peak and valley wavelengths are indicated on a spectrum.  

These wavelengths are the ones indicated in the peak table.  

They can be printed.  

 

 
 

Fig. 6-10 
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6.8  Smoothing of Spectrum  

 

Select the Smooth (S) command from the Data (D) menu or click 

the     button.  The window in Fig. 6-11 will open.  

 

 
 

Fig. 6-11 

 

 

Set the following parameters on this window.  

 

(1) Function type  

 

Select a smoothing method from the following three.  

• Savitsky-Golay  

• Mean 

• Median 

 

(2) Smoothing order  

 

Set a smoothing order.   

Input range:  2 to 4  

 

(3) Number of points  

 

Set the number of points to be used in calculation.  

Input range:  5 to 101, Initial value:  7  

 

(4) Number of times  

 

Set the number of smoothing operations.  

Input range:  1 to 100  

For returning to the original status (before calculation), click  

    .  

6.8  Smoothing of Spectrum 
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6.9  Derivative Operation on Spectrum  

 

Select the Derivative (D) command from the Data (D) menu or 

click the     button.  The window in Fig. 6-12 will open.  

 

 
 

Fig. 6-12 

 

 

(1) Derivative order  

 

Set a derivative order.  

Input range:  1 to 4  

 

(2) Smoothing order  

 

Set a smoothing order.  

Input range:  2 to 4  

 

(3) Number of points  

 

Set the number of points to be used in calculation.  

Input range:  5 to 101, Initial value:  15  

 

(4) Overlay derivative  

 

Spectra before and after derivative operation are overlaid 

for display.  Note that the value on Y axis is not the one 

after derivative operation.  

For returning to the original status (before calculation), click  

    .  

6.9 
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6.10  Overlaid Display of Spectra  

 

This function is convenient for comparison of two or more 

spectra.   

There are 3 methods selectable for this function.  

 

(1) Select the Overlay (O) command from the Data (D) menu.  

 

 
 

Fig. 6-13 

 

 

Click the Insert button and a list of files that allow overlay is 

displayed.  Select a file name and click the Open button.  

The selected sample name is added and displayed as in 

Fig. 6-14.  Now click the Close button.   

 

 
 

Fig. 6-14 

 

 

6.10  Overlaid Display of Spectra 
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(2) Open a file to be overlaid to display its data.  

 

 
 

Fig. 6-15 

 

 

Drag the blue profile of the displayed spectrum so that the 

mouse pointer comes onto the target spectrum.  When the 

mouse pointer changes as shown in Fig. 6-16, drop the 

blue profile.  

 

 
 

Fig. 6-16 

 

 

(3) Open a file as in (2) above.  Click the spectrum to be 

overlaid and press Ctrl+C on the keyboard or select the 

Copy (c) command from the Edit (E) menu.  Then click the 

target spectrum and paste the first spectrum on it by Ctrl+V.  

The spectra are now overlaid.  

 

6.10 
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(a) Deletion from Overlaid Display  

Select the Overlay command from the Processing 

menu.  In case you want to delete the spectrum 

having sample name “Filter 02,” select the sample 

name and click Delete.   

 

 
 

Fig. 6-17 

 

 

(b) Display of Selected Spectrum Alone from Overlaid 

Spectra  

Click     (Display spectrum) on the Spectrum toolbar.  

 

 
 

Fig. 6-18 

 

 

Click the spectrum not to be displayed.  

Click OK.  In this case, spectra Nos. 1 and 2 will be 

displayed.  Printout of this data covers not the spectra, 

but the sample names, analytical conditions, etc.  

After file saving in the current state, 4 spectra will be 

displayed upon loading the file again.  

To be displayed  

Not to be displayed  

 

6.10  Overlaid Display of Spectra 
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6.11  Arithmetic Operation between Spectra  

 

Shown here is an example of obtaining the difference between 

two overlaid spectra.   

Display the spectrum for arithmetic operation.  Now, click the 

Arithmetic (A) command on the Data (D) menu or click the 

(spectral calculation) on the Processing toolbar.  A window as in 

Fig. 6-19 will open.   

 

 

 

 
 

Fig. 6-19 

 

 

(1) The sample name of the file open in the window (file name 

in parentheses) is indicated.  Select the file for arithmetic 

operation.   

 

(2) The spectrum selected in (1) is displayed here.  

 

(3) A factor for the spectrum selected in (1) is settable.   

For multiplying the spectrum by a factor, click Calculate 

here.  

 

(4) Apply a check mark here for arithmetic operation between 

two spectra.  

As a result, the window as in Fig. 6-20 appears.  

(2) Spectrum 

(1) Sample name 

(3) Factor input 

(4) Spectral calculation 
ON/OFF  

6.11 
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Fig. 6-20 

 

 

(5) Another sample name (file name in parentheses) is 

indicated.  Select the file for arithmetic operation.   

 

(6) The spectrum selected in (5) is displayed.  

 

(7) Set the factor for the spectrum selected in (5).  

 

(8) Select a mathematical operator for the two spectra.   

+:  Addition, -:  Subtraction, *:  Multiplication, /:  Division  

 

After setting, click Calculate.  The result of arithmetic operation 

is displayed as shown in Fig. 6-21.   

 

(6) Spectrum 

(5) Sample name 

(7) Factor input (8) Mathematical operator 

6.11  Arithmetic Operation between Spectra 
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Fig. 6-21  After Arithmetic Operation 

 

 

Click Save As, and the result of calculation can be saved in file.  

Result of arithmetic operation 

6.11 
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6.12  Area Calculation  

 

An area value is obtainable by integration in the specified range 

of the presently displayed spectrum.   

Select the Integration (I) command from the Data (D) menu or 

click the     (area calculation) button on the Processing toolbar.  

The window as in Fig. 6-22 will appear.   

 

 
 

Fig. 6-22 

 

 

Click Start and input the range for area calculation.  Or move 

and right-click the cursor, and a value will be entered.  In the 

same way, enter the end wavelength.  After entry, click 

Calculate.  The result will be displayed.  

For printout, click Print.  In order to print a spectrum and the 

result of calculation, apply a check mark to “With spectrum 

record” and click Print.   

When clicking the OK button after calculation, its result will be 

saved.  Operation will be reset by closing the data processing 

window or clicking the     button on the Processing toolbar.   

Clicking Cancel closes the window.  

 

6.12  Area Calculation 
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For scale expansion, specify the area to be expanded with the 

mouse.  Draw a rectangle with the mouse button held down.   

 

 
 

Fig. 6-23 

 

 

Then, release the button, and the specified area will be 

expanded as shown in Fig. 6-24.   

 

 
 

Fig. 6-24 

 

 

Double clicking the right mouse button returns the scale to the 

original one.   

6.12 
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The principle of calculation is shown below.  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Fig.6-25 

 

 

The elements (D1 to Dn) of a spectrum are subjected to the 

following calculation for obtaining the area value.   

 

S3 = {D2 + D3 + … Dn-2 + Dn-1 + D1 + Dn}/2∗∆λ 

S2 = (D1 + Dn) ∗ {∆λ∗ (n-1)} 

(D1 + Dn) ∗ (Section start wavelength (WL1)) –  

(Section end wavelength (WL2)) 

S1 = S3 – S2 

D1 : Spectral data at section start wavelength  

Dn : Spectral data at section end wavelength  

∆λ : Sampling interval  

 

In the time scan mode, change as follows.  

Start wavelength (WL1) → end time (T2)  

End wavelength (WL2) → start time (T1)  

6.12  Area Calculation 

 

 

Section start 
wavelength  

Section end 
wavelength  
 

Specified range  

Dn 

Dn - 1

D2 

D1 

∆2 

WL1

S2 

S1 

WL2 WL1

Sb 

Sa 

WL2 

Sc 

Sd 
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6.13  Transfer of Data to Microsoft(R) Excel  

 

Measured data can be transferred to a worksheet of Microsoft(R) 

Excel.   

Procedure is given below.  

 

(1) Click the     (properties) button and select the Report tab.  

A window as in Fig. 6-26 will open.  In Print Method, select 

“Use Microsoft(R) Excel.”  Also select the data to be 

transferred (peak table and data list in case of wavelength 

scan).  Then, click OK.  

 

 
 

Fig. 6-26 

 

 

(2) Click the     (Report) button and the Microsoft(R) Excel 

will automatically start to read the data.  The subsequent 

procedure concerns the Microsoft(R) Excel operation.  

 

 
 

Fig. 6-27 

6.13 
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(3) Data can be saved with extension code xls of Microsoft® 

Excel. 

Select File - Save Copy As and enter a file name.   

 

 
 

Fig. 6-28 

 

 

(4) Upon closing the Microsoft® Excel, the window in Fig. 6-29 

appears.  Now close this window.  The original data 

processing window will appear again.  

 

 
 

Fig. 6-29 

6.13  Transfer of Data to Microsoft(R) Excel 
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6.14  Pasting of Spectra to Microsoft(R) Word  

 

In report preparation, spectra can be pasted as they are.  

Make the spectral data active (click the relevant spectrum) and 

then select the Copy command from the Edit menu.  Now open 

the Microsoft(R) Word and select the Paste command from the 

Edit menu.  The data can be pasted to a Microsoft(R) Word text.  

Peak tables and/or kinetics data can also be pasted in the same 

way.  By double-clicking the pasted spectrum shown in  

Fig. 6-30, functions such as scale change and calculation result 

display are applicable.  The spectrum can be selected as a 

meta-file by the Paste Special (S) command with a form chosen.  

In the same way, peak tables and/or kinetics data can also be 

pasted. 

 

 
 

Fig. 6-30 

 

 

When you double-click the pasted spectrum, you can edit it.  

Right-clicking on it permits editing such as scale change.   

A change made here will be brought into a Microsoft(R) Word 

text.  

 

NOTE: he above editing in the Microsoft(R) Word can be made 

with a PC in which the Microsoft(R) Word and FL 

Solutions program are installed.  

 

6.14 
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For pasting a spectrum to the Microsoft(R) Excel, specify  

“Paste Special.”  The dialog box in Fig. 6-31 will appear.  

 

 
 

Fig. 6-31 

 

 

Click OK will paste the spectrum.   

6.14  Pasting of Spectra to Microsoft(R) Word 



6 - 27 

6.15  Conversion of Data to ASCII Text File  

 

A file conversion function is provided for processing of data with 

other spreadsheet software.  Conversion can be made to the 

following three data files.  

• JCAMP-DX file (*.dx)  

• ASCII text file (*.txt)  

• Graph meta file (*.wmf)  

 

NOTES: 1. Date/time, analytical conditions and data list (raw 

data) will be converted into a JCAMP-DX file  

2. The items selected at the Report tab of 

Properties will be converted into an ASCII text 

file.  

 

(1) Open the data processing window.  

 

(2) Click the Save As (A) command in the File (F) menu.   

 

(3) A window as in Fig. 6-32 will open.  

Select “ASCII text files (*.txt)” at “Save as type.”   

And specify the folder for saving.   

 

 
 

Fig. 6-32 

 

 

6.15 



6 - 28 

(4) Enter a file name and click Save.  

 

 
 

Fig. 6-33 

 

 

File conversion is effective for a data file in any measurement 

mode.  The selected data is separated by tab.   

6.15  Conversion of Data to ASCII Text File 
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6.16  Renaming Your Sample  

 

After measurement, the sample name of saved data can be 

changed.  

Proceed s follows.  

 

(1) Open the data file for renaming.  

 

(2) Select the Properties (O) command from the Edit (E) menu 

or click the     button.  

 

(3) A window as in Fig. 6-34 will open.  Click the Info tab.  

 

 
 

Fig. 6-34 

 

 

(4) Input a new sample name for “Sample name” and click OK.  

 

NOTE: This function is effective in the wavelength scan, time 

scan and 3-D Scan modes.   

For saving existing data in a different sample name, 

select the Save As (A) command from the File (F) 

menu.  

6.16 
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6.17  Printing of Wavelength and Photometric Values under Display  

 

This program provides a function for acquiring data such as 

presently displayed wavelength and photometric values, and 

traced value on the data processing window.  These data can 

be printed.   

Select the Data read (R) command from the Tools (T) menu.   

A window as in Fig. 6-35 will appear.  

 

 
 

Fig. 6-35 

 

 

For reading presently displayed wavelength and photometric 

values:  

Move the mouse pointer onto the monitor window and right-click 

it there.  A window as in Fig. 6-36 will be presented.  

 

 
 

Fig. 6-36 

6.17  Printing of Wavelength and Photometric Values under Display 
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Select “Present data read” and the photometric value on the 

monitor window will be read on the window shown in Fig. 6-35.  

Display becomes as shown in Fig. 6-37.  

 

 
 

Fig. 6-37 

 

 

For reading data from data processing window  

Display the window for data readout as instructed above and 

move the mouse pointer onto date processing window.   

Right-click the mouse there, and a window as in Fig. 6-38 will 

open.   

 

 
 

Fig. 6-38 
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When you select “Trace value read,” a window as in Fig. 6-39 

will appear.  

 

 
 

Fig. 6-39 

 

 

In reading data from the data processing window, sample name 

information is displayed.  Sample names can be edited.   

Click the sample name column, and input is allowed.  

The relevant data can be printed.  From the File (F) menu, 

select the Print (P) command or click the    (Print) button.  

Data can be deleted by the following method.  Click the data 

value and select Delete.  For deletion of all data, select Delete 

All.   

 

6.17  Printing of Wavelength and Photometric Values under Display 
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6.18  Reference to Spectrum Measured in Photometry Mode  

 

When the quantification method is peak area, peak height or 

derivative in the photometry mode, wavelength scan will be 

carried out and according to its result, a calibration curve will be 

prepared.  The spectrum measured in this case can be 

displayed and printed.  

Open the data file.  Right-click the numerical part of standard 

data or sample data and select “Spectrum reference.”  Or click 

a numeral and select the Spectrum reference (R) command from 

the Data (D) menu.   

 

 
 

Fig. 6-40 
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A spectrum appears as shown in Fig. 6-41.  Spectrum tracing 

and scale change are possible.  The spectrum can be printed 

by selecting the Print (P) command from the File (F) menu or 

click the     button.   

 

 
 

Fig. 6-41 

6.18  Reference to Spectrum Measured in Photometry Mode 
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7. MORE CONVENIENT OPERATING METHODS  

(APPLICATION PART)  

 

 

7.1  For Always Starting Up with Same Analysis Method  

 

The FL Solutions program can be started with the analysis 

method specified.  Select Tools - Options as in Fig. 7-1.  

 

 
 

Fig. 7-1  Tools Menu 

 

 

Now select the Startup tab as in Fig. 7-2.   

Select “Use fixed method” and click Set F-2500 Method when 

the Model F-2500 is used or Set F-4500 Method when the 

Model F-4500 is used.  

 

 
 

Fig. 7-2  Startup Tab 
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A window as in Fig. 7-3 will open.  Set your method file here.   

 

 
 

Fig. 7-3 

 

 

This function is validated when the FL Solutions program is 

restarted.   

7.1  For Always Starting Up with Same Analysis Method 
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7.2  Online/Offline Setting of Photometer  

 

Connection with the photometer can be set offline.  And this 

connection can be made again.   

Select the Instrument command from the Tools menu or click the  

    button.  The window in Fig. 7-4 appears.  This window is 

for connection with the photometer.  

 

 
 

Fig. 7-4 

 

 

Click the instrument name and then the Cut button.  The offline 

status will be set.  For online setting, click the Connect button.  

Initialization will be carried out and the monitor window will 

appear.  

 

 

 

7.2 
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7.3  Check of Data File Information  

 

You can check the conditions under which specific data was 

measured.   

For instance, when you want to know the analytical conditions or 

measurement date of a data file when opening it, specify and 

right-click the file and select Properties as shown in Fig. 7-5.   

 

 
 

Fig. 7-5 

 

 

The window in Fig. 7-6 will open.  Information can be checked 

by clicking the Info and Scan tabs.  

 

 
 

Fig. 7-6 

 

7.3  Check of Data File Information 
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On selection of Quick Viewer, a window appears as shown in  

Fig. 7-7.  So a spectrum can be checked.  

 

 
 

Fig. 7-7 

 

 

Quick Viewer is usable when extension code is *.fds, *.fdt or 

*.fd3.  The same operation as above can be performed by using 

Explorer.   

The information on the open data such as analytical conditions 

can be checked.  

 

Select the Properties (O) command from the Edit (E) menu or 

click the    button.  The Info tab contains the date of 

measurement and the instrument used, and the Scan tab 

contains measuring conditions such as measuring wavelength, 

scan speed and slit width.  

 

 
 

Fig. 7-8  Info Tab 

7.3 
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Fig. 7-9  Scan Tab 

 

 

When multiple data are displayed, click the drop-down list box of 

sample names and select the sample name of the desired data.  

7.3  Check of Data File Information 
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7.4  Saving of Analysis Method  

 

The set analysis method can be saved as a file.  So instead of 

setting the method each time, you can just call out the file for 

setting.  Select the Method command from the Edit menu on 

monitor window or click the     button.  

 

 
 

Fig. 7-10 

 

 

When the setting is finished, click Save As and enter a file name.  

For calling out the saved file, click Load and select the file.   

7.4 
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7.5  Even Log  

 

The date/time of lamp exchange and the occurrence of troubles 

can be recorded in a log.  Select Tools - Event Log.  

 

 
 

Fig. 7-11 

 

 

The window in Fig. 7-12 shows the occurrence time of 

communication errors, etc., and user notes.  For displaying only 

errors or only user notes, put a check mark at either item.  

 

 
 

Fig. 7-12  Event Log Tab 

 

 

7.5  Even Log 
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For adding a note, select the User Notes tab, put an explanation 

in the Description field and click the Add Note button.  

Maximum number of input characters:  127 characters  

 

 
 

Fig. 7-13  User Notes Tab 

7.5 
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7.6  Check of Program Version  

 

The version of the program currently being used can be checked.  

Select the About FL Solutions (A) command from the Help menu.   

 

 
 

Fig. 7-14 

 

 

A window as in Fig. 7-15 will open.  So check the program code.   

 

 
 

 

Fig. 7-15 

7.6  Check of Program Version 
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7.7  Saving of Sample Table  

 

Sample tables can be saved.   

This is convenient for editing the sample table under the same 

name each time.  

 

 
 

Fig. 7-16  Sample Table 

 

 

After editing the sample table, click Save As and the window in 

Fig. 7-16 will appear.  Enter a file name.  For calling out the 

saved file (*.fls), click Load and select the file.  

 

 
 

Fig. 7-17 

7.7 
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7.8  Change of Window Display  

 

When selecting the View (V) menu, display/non-display of 

toolbars and method of displaying multiple spectra can be 

selected.  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Monitor window Data processing window 

 

Fig. 7-20  View Menu Commands 

 

 

Scale Y Axis Up : Y axis scale is doubled for 

display.  

 

Scale Y Axis Down : Y axis scale is contracted by half 

for display.  

 

Reset Y Axis, Reset Axes : The scale set under the Monitor 

tab is taken.   

 

Autoscale Y Axis, Autoscale : Scale is adjusted to spectrum 

size for display.   

Display/ 
non-display 
setting 

7.8  Change of Window Display 
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The method of displaying multiple spectra is selectable.  

 

• Overlay 

 

 
 

Fig. 7-21 

 

 

• Stack 

 

 
 

Fig. 7-22 
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• Tile 

 

 
 

Fig. 7-23 

 

NOTE: When six, seven or more spectra are displayed, there 

is a possibility of the spectra becoming too small, or not 

all the traced values can be displayed.  In this case, 

use the Overlay (O) command of Data (D) menu to 

delete unnecessary spectra.  

7.8  Change of Window Display 



7 - 15 

7.9  Check of Photometric Value at Specified Wavelength  

 

This is a function for shifting to the specified wavelength.  It is 

usable for checking the optical axis, etc.  

Open the monitor window and select the Set Wavelength (W) 

command from the Spectrophotometer (S) menu or click the  

(Set Wavelength) button.  

A window as in Fig. 7-24 will open.  

 

 
 

Fig. 7-24 

 

 

Input target wavelength values and click OK.  

Wavelength is now driven to the specified one and a photometric 

value is read on the monitor window.  (Refer to (2) in 1.6.)  

 

• Wavelength drive to zero-order light 

For checking the optical axis, etc. in the zero-order light or 

moving the instrument, wavelength needs to be driven to the 

zero-order light.  Open the window shown in Fig. 7-24 and 

set wavelength at 0.  Then click OK, and wavelength will be 

adjusted to the zero-order light.  

 

NOTE: For termination with wavelength kept at the zero-

order light, select “Close the monitor window, but 

keep the lamp operating?” in shutting down the 

application (terminating the program).  “Close the 

monitor window, but keep the lamp operating?” must 

also be selected for turning off the photometer 

power supply with the wavelength position kept 

unchanged.  

7.9 
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7.10  Collective Printing of Files  

 

Wavelength scan data files (*.uds) and time scan data files 

(*.udt) can be collectively printed.  

From the File (F) menu, select the collective spectrum recording 

(L) command.  A window as in Fig. 7-25 will appear.  

 

 
 

Fig. 7-25 

 

 

Click Select file.  

 

 
 

Fig. 7-26 

 

 

7.10  Collective Printing of Files 
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Specify the folder of a file to be printed at “Look In” and specify 

the file.  Click Open (O).  

 

 
 

Fig. 7-27 

 

 

After check, click Print.  Printing starts.  The items to be 

printed are the saved ones.  A maximum of 100 files can be 

specified.  

7.10 
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8.  MEASUREMENT USING OPTIONAL ACCESSORIES  

 

 

For the cable connection method for each accessory, refer to the 

instruction manual attached to the accessory.  Explanation is 

given here on operations after setting of your analysis method, 

which is required as instructed in Sections 2 to 5.  

 

8.1  Use of Sample Sipper  

 

Hook up the sample sipper to the spectrophotometer.   

The parameters for the sipper are settable on its front panel.   

Explained here is the procedure for creating a calibration curve 

and measuring an unknown sample in the Photometry mode.  

 

A message box appears in the standard measurement session, 

so operate in accordance with the messages.  A message box 

does not appear in the sample measurement session.  

Measurement can be started just by pressing the sipping lever of 

the sample sipper.  

 

NOTES: 1. When using the sample sipper, remeasurement, 

interrupt measurement and blank measurement 

cannot be made.  But remeasurement of 

standards is possible.  

2. When repeat measurement is set, the standards 

will be measured by the set number of times.  

Samples will be measured only once.   

 

Select the Measure command from the Spectrophotometer menu 

or click the     (measurement) button on the toolbar, and the 

window in Fig. 8-1 will open.   

 

 
 

Fig. 8-1 

8.1.1 When Not Using  

a Sample Table  

 

8.1.1 



8 - 2 

Press the sipping lever and measurement starts.  A message 

box for the second measurement now appears.   

For carrying out remeasurement or for skipping the second 

standard measurement, select the relevant item with the mouse 

(put a bullet in its radio button) and then click Yes.   

When clicking No, the current measurement sequence will be 

terminated.   

For restarting measurement, click the    button.   

Measurement then starts from the 1st standard.  

 

 
 

Fig. 8-2 

 

 

On completion of standard measurement, the window in Fig. 8-3 

will open.  

 

 
 

Fig. 8-3 

 

 

8.1  Use of Sample Sipper 
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By clicking OK with the mouse, a calibration curve is drawn and 

then samples can be measured.  When the window in Fig. 8-4 

appears, you should press the sipping lever.   

Measurement results appear at the area indicated by (1) in  

Fig. 8-5.   

By clicking Cancel, the measurement is terminated, and the 

standards’ data is not saved.   

Now select “Repeat the last measurement” and click OK.   

Set the final standard in place and press the sipping lever.  

When repeat measurement has been set, measurement is 

started from the 1st one (Repl.No.1) for that standard.  

 

 
 

Fig. 8-4 

 

 

 
 

Fig. 8-5 

 

 

When measurement is finished, click the End button, and the 

data will be saved.  

(1) 

8.1.1 
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For remeasuring any of the standards after their measurements, 

click its data as shown in Fig. 8-6.  Then click the Remeasure 

button.  

 

 
 

 

Fig. 8-6 

 

 

A message box will open as in Fig. 8-7, so press the sipping 

lever.  

 

 
 

Fig. 8-7 

 

 

When a standard is remeasured, the calibration curve is 

recalculated and sample data is also recalculated based on the 

curve and then displayed.  To saved the recalculated data, click 

the End button or the     (save) button on the toolbar.   

 

A message box is displayed in both standard and sample 

measurement sessions.  So operate according to the messages.  

When the message box appears, press the sipping lever of the 

sample sipper.  

 

NOTE: When the sample sipper is used, blank measurement 

cannot be made. 

8.1.2 When Using a 

Sample Table 

8.1  Use of Sample Sipper 
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Select the Measure command from the Spectrophotometer menu 

or click the     (measurement) button on the toolbar, and the 

window in Fig. 8-8 will open.  

 

 
 

Fig. 8-8 

 

 

Press the sipping lever and measurement starts.   

For measurement of the 2nd and subsequent standards, a 

message box as in Fig. 8-9 will open.  For remeasurement or 

for skipping measurement of the next standard, select the 

relevant item with the mouse (put a bullet in its radio button) and 

then click Yes.  When clicking No, the current measurement 

sequence will be terminated.   

For restarting measurement, click the     button.  

Measurement then starts from the 1st standard.  

 

 
 

Fig. 8-9 

 

 

8.1.2 
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On completion of standard measurement, the window in Fig.  

8-10 will open.  

 

 
 

Fig. 8-10 

 

 

By clicking OK with the mouse, a calibration curve is drawn and 

then samples can be measured.   

By clicking Cancel, the measurement is terminated, and the 

standards’ data is not saved.   

For remeasurement of the final standard, select “Repeat the last 

measurement” and click OK.  Set the final standard in place and 

press the sipping lever.  When repeat measurement has been 

set, measurement is started from the 1st one (Repl.No.1) for that 

standard. 

 

In the case of sample measurement also, a message box as in 

Fig. 8-11 will appear.  Press the sipping lever, and 

measurement of the 1st sample starts.   

 

 
 

Fig. 8-11 

 

8.1  Use of Sample Sipper 
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For measurement of the 2nd sample, a message box as in  

Fig. 8-12 opens.  

 

 
 

Fig. 8-12 

 

 

Press the sipping lever for measuring the 2nd sample.   

For skipping this sample (and measuring the 3rd sample), select 

“Skip this sample?” and click the Yes button with the mouse.  

For remeasurement, select “Repeat the last measurement?” and 

click Yes button with the mouse.  When repeat measurement 

has been set, measurement is started from the 1st one 

(Repl.No.1) for the 1st sample.  

In case of interrupt measurement, select “Insert a new sample 

into the sequence” and click the Yes button with the mouse.   

A message box as in Fig. 8-13 opens, so click the OK button.   

 

 
 

Fig. 8-13 

 

 

8.1.2 



8 - 8 

For remeasurement after a series of measurements, click the 

data to be remeasured as in Fig. 8-14.  Then click the 

Remeasure button.  

 

 

Fig. 8-14 

 

 

A message box will open as in Fig. 8-15.  Press the sipping 

lever, and measurement starts.  When remeasuring a standard, 

the calibration curve is recalculated and sample data is also 

recalculated based on the curve and then displayed.  To save 

the recalculated data, click the     (Save) button. 

 

 

Fig. 8-15 

 

 

(1) When not Using Sample Table  

 

Set your analysis method, and when the monitor window 

appears, press the sipping lever.  Measurement starts.   

 

(2) When Using Sample Table  

 

Select the Measure command from the Spectrophotometer 

menu or click the     (measurement) button on the toolbar.  

A message box opens.  Follow the messages given.  

8.1.3 In Wavelength 

Scan or Time 

Scan Mode  

8.1  Use of Sample Sipper 
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8.2  Use of AS-3000 Intelligent Autosampler  

 

Set the rack parameters, injection volume and other items with 

the AS-3000 intelligent autosampler.  For details, refer to the 

instruction manual attached to the AS-3000.   

 

Select the Measure command from the Spectrophotometer menu 

or click the     (measurement) button on the toolbar.   

Then, press the START key on the AS-3000 intelligent 

autosampler.  Measurement will start.  

 

NOTE: In measurement without using a sample table, 

remeasurement, interrupt measurement and blank 

measurement cannot be done. 

 

NOTE: In measurement when using a sample table, 

remeasurement, interrupt measurement and blank 

measurement cannot be done.  But remeasurement of 

standards is possible.  The standard to be 

remeasured should be set in the initial test tube 

position.  

 

For measurement after completion of settings: 

 

(1) Select the Measure command from the Spectrophotometer 

menu in the FL Solutions program or click the 

(measurement) button on the toolbar.   

The window in Fig. 8-16 opens.  

 

 

Fig. 8-16  For Start from Calibration Curve Creation 

 

 

(2) Press the START key on the AS-3000.  

 

(3) Measurement is started.  

8.2.1 When Not Using  

a Sample Table  

8.2.2 When Using a 

Sample Table  

 

8.2.1 
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8.3  For Analog Output  

 

For connection, use the analog output terminal.  Select the 

Analog Output Gain command from the Utility menu.   

 

 
 

Fig. 8-17 

 

 

This is a setting of data value corresponding to analog output of 

1 V.  

Analog output value (V) becomes as follows.  

 

• Model F-4500 

Low : (Data value - photometric value lower limit)/1024  

High : (Data value - photometric value lower limit)/8192  

 

• Model F-2500   

Low : (Data value)/1024  

High : (Data value)/8192  

 

8.3  For Analog Output 
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APPENDIX A  DETAILS ON QUANTITATION 

 

 

A.1 Foreword 

In the Photometry mode of the F-2500 spectrophotometer, there 

are four calibration types. 

 

• Linear working curve 

• Quadratic working curve 

• Cubic working curve 

• Multiple segment working curve 

 

These are explained in more detail below. 

 

A.2 Linear Working Curve (1st order) 

 

Regression line is determined via least squares method from a 

maximum of 20 data.  The calculation formula is as follows : 

x = A1· y + A0 

A1 = 

( )

y x
n

y x

y
n

y

i i i i

i i

− ∑ ⋅ ∑∑

− ∑∑

1

12 2

, A0 = 
x

n
A

y

n

i i∑
− ⋅

∑
1  

where, x :  Concentration of each sample (input value) 

y :  Data on each sample (measured value) 

n :  Number of samples 

 

A.3 Quadratic Working Curve (2nd order) 

 

A quadratic curve is determined via least squares method from a 

maximum of 20 data.  The calculation formula is as follows : 

x = A2 · y
2
 + A1 · y + A0 

A2 = 
( ) ( ) ( ) ( )

( ) ( ) ( )}
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where, x :  Concentration of each sample (input value) 

y :  Data on each sample (measured value) 

n :  Number of samples 

 

A.4 Cubic Working Curve (3rd order) 

 

A cubic curve is determined via least squares method from a 

maximum of 20 data.  The calculation formula is as follows : 

X = A3 · Y
3
 + A2 · y

2
 + A1 · y + A0 

where, x :  Concentration of each sample (input value) 

y :  Data on each sample (measured value) 

n :  Number of samples 

 

A.5 Multiple Segment Working Curve (Segmented) 

 

The calibration curve is apt to bend when measuring turbid 

samples or the like.  Use of a quantification program allows 

correcting the calibration curve by using up to 20 standards.  

Figure A-1 shows an example of curve correction.  For the part 

which exceeds the measuring range of the standards, simply 

extend the line as it is. 

 

 

Fig. A-1  Correction of Curve Bending 

 

STD5

STD4

STD1

STD6 

STD3

STD2

CONC

Data 
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<Notes on Preparation of Multiple Segment Working Curve> 

 

(1) A correct calibration curve can be created only when the 

measured value increases or decreases monotonically 

versus the concentration value.   Especially when the 

inclination is negative-going, be sure to measure a blank 

having a data value larger than the other standards.   

A curve not showing a monotonic increase will appear as in 

Fig. A-2.  And when the data value of the blank is small, 

regardless of a negative-going inclination, the curve will 

appear as in Fig. A-3. 

 

 

Fig. A-2  Example of Curve without Monotonic Increase 

(unsuitable curve) 

 

 

STD5

CONC 

Data

STD4

STD1

STD2

STD3

STD6

Data

STD1

CONC

STD2

STD3 

STD4 

STD5

Fig. A-3 Example of Negative-going Curve where 

Measured Value of Blank is Small  

(unsuitable curve) 
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(2) Remeasurement of Standards 

 

The standards can be remeasured after once preparing a 

calibration curve.  The curve prepared in such case will 

appear as in Fig. A-4. 

 

 

Fig. A-4  Calibration Curve when Standards are Remeasured 

 

 

STD5 
Redrawn 
calibration curve

STD6

STD4

STD3

STD2

STD1

Data 

Initially 
measured STD1

CONC

 

Remeasured 
STD1 
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APPENDIX B  DETAILS OF RATE ANALYSIS FUNCTION 

 

 

B.1 Foreword 

 

Rate analysis is used in the analysis of enzyme reactions.  It is 

utilized for clinical and biochemical tests by reagent 

manufacturers, hospitals and so on.  A computer is used to 

calculate the concentration from the variation in data per unit 

time, and the result is displayed and printed out. 

 

B.2 Calculation Method 

 

A timing chart for rate analysis is shown in Fig. B-1.  Data is 

acquired when the initial delay time has elapsed after pressing 

the Measure button.  A regression line is determined from this 

data via the least squares method, and the gradient and activity 

value are calculated.  The calculation formula is as follows. 

 

 

Data :  A0, A1, A2, A3, A4… 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Fig. B-1 

 

Td :  Initial delay time 
Tm :  Measurement time 
Tc :  Sampling interval 
Tt :  Calculation time 

Data

Time 
Td Tc 

Tt

Tm 

Start of 
measurement 

A1 

A5 

A4 
A3 

A2 

A6

A7 

A0 
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Prepare a regression line via least squares method from the 

measured data, and obtain a determination coefficient. 

y = ax + b 

where, 

a = 
( )

x y
x y

n

x
x

n

i i

i i

i

i

−
∑∑

∑

−
∑

∑
2

2
 b = 

( )
y

a x

n
i

i

−
∑

∑
*

 

xi :  Time (sec) of each data 

yi :  Value of each data 

n :  Number of samples 

 

The determination coefficient CD becomes as follows : 

CD = 
( )

( ) } ( ) }{{ ∑ ∑ ∑−∑−

∑ ∑ ∑−

2

i

2

i

2

i

2

i

2

iiii

yynxxn

yxyxn
 

 

• Gradient (variation per minute) 

Di = 
a

Tk
 = 60a (/min) 

 

• Activity 

Ci = k · Di 

 

• R (determination coefficient) 

R = CD  = 
( )

( ) } ( ) }{
n x y x y

n x x n y y

i i i i

i i i i

− ∑∑∑

− ∑ − ∑∑∑




2

2 2 2 2

 

 

• R2 

R2 = (R)
2
 = 

( )

( ) } ( ) }{
n x y x y

n x x n y y

i i i i

i i i i

− ∑∑∑

− ∑ − ∑∑∑




2

2 2 2 2

 

 

NOTE : If the range for rate calculation does not coincide with 

the actual measured data range, then use only the 

measured data within that range for the calculation. 
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APPENDIX C DETERMINATION COEFFICIENT OF  

CALIBRATION CURVE 

 

C.1 Calculation of Determination Coefficient 

 

The determination coefficient and other factors are calculated via 

the following formula. 

 

 

 

 

 

 

 

 

 

 

 

 

An : Photometric or average value of standards 

Cn : Concentration on approximation curve 

versus A 

Cstdn : Concentration of standard (input value) 

N : Number of standards 

 

DIFF :  DIFFn = Cn - Cstdn 

RD :  RDn = 
DIFF

A
× 100  

    A
A

N

n

=
∑

 

t :  tn = 
DIFF

DIFF

N

n

2

1

∑

−

 

Determination coefficient :  R = 
( ) ( )

( )

C C C C

C C

n n stdn

n

− − −∑∑

−∑

2 2

2
, 

    R2 = (R)
2
 

 

 

 

A3

A2

A1

Data

   C1 C2 C3 
  Cstd1  Cstd2   Cstd3

Conc 
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C.2 Usage of Determination Coefficient 

 

The determination coefficient indicates the goodness of fit of the 

measured standards and the prepared calibration curve.   

The closer this value is to “1”, the better the fit of the measured 

values and calibration curve.  If the value is far from “1”, then 

the standards must be remeasured or the calibration curve mode 

must be changed.  Examples of determination coefficients upon 

changing the calibration curve mode are given below. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

With the above standard data, it can be seen that a quadratic 

curve provides a better result.  A calibration curve, which was 

formerly judged through skill or experience, can thus be judged 

more easily through numerical means. 

 

Data

x : standard measurement 
points 

When calibration curve type is 
set to linear, 
determination coefficient < 1 

Conc

Data

Conc

When calibration curve type is 
set to quadratic, 

determination coefficient ≒ 1 
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APPENDIX D  INTEGRATION METHOD 

 

D.1 Foreword 

 

The integration methods used in the FL Solutions program are 

explained next. 

 

D.2 Integration Methods 

 

The following three methods are available in the FL Solutions 

program. 

 

• Rectangular 

• Trapezoid 

• Romberg 

 

The rectangular method is the simplest one among the above 

three.  Since one sampling cycle is equivalent to the width of 

each sectional area, the total of all data points including peaks 

approximates the area to be obtained. 

The object area shown in Fig. D-1 is the total of the rectangular 

sections obtained from linear approximation of the curve drawn 

via the data points.  If a peak has few data points, the 

approximation will be a rough estimate. 

 

 

Fig. D-1 

 

 

D.2.1 Rectangular 

Method 
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This method is a further improvement on peak area calculation.  

The section of each sampling cycle is indicated by a rectangle on 

which a triangle is formed.  The object area is the sum of all 

these areas. 

 

 

Fig. D-2 

 

By taking just one rectangle, the area of the rectangular part Ir is 

expressed by the following formula. 

 

Fig. D-3 

 

A triangular part is added to this rectangle.  Assuming the area 

of this component is IT and the area of the triangular part is It, we 

obtain the following : 

IT = It + Ir = 
f f

x f x
f f

x
2 1

1

1 2

2 2

−
+ =

+







  

Considering this with respect to the whole area, we obtain : 

D.2.2 Trapezoid 

Method 

x

f2

f1 

Ir = f1x 

where, x :  Sampling interval

f1 :  Height on left side

of rectangle 
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IT = 
f

f f
f

x
n

n1

2 1
2 2
+ + + +









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−
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The Romberg method is the most accurate of the three methods 

discussed here.  The trapezoid method provides different step 

sizes (sampling intervals) for area determination with high 

accuracy.  In this method based on the sum of errors, two 

different step sizes for individual cases are available.   

However, unlike the conventional (classic) method of continuous 

approximation, an arbitrary decrease in step size is not allowed 

(as in case of an increase in the X-axis direction) for the purpose 

of accurate integration.   This is because the data points that 

define the spectrum are handled as average data.  Still, an 

increase in step size can be made using two or four factors if this 

is necessary for applying the Romberg method.  The Romberg 

method will take the following form. 

 

(1) Integration is made via trapezoid method per data point. 

 

(2) Integration is made via trapezoid method per two data 

points. 

 

(3) By combining the above two results, the following formula is 

obtained. 

 

 IR = In + 
I I
n n
−

2

3
 

where, IR = Integration by Romberg method 

In = Trapezoid integration per data point 

I2n = Trapezoid integration per 2 data points 

 

 

D.2.3 Romberg 

Method 
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APPENDIX E  DESCRIPTION OF FLUOROMETRY 

 

E.1 Description of Fluorometry 

 

 

 

 

 

 

Fig. E-1  Typical Organic Molecular Energy Level 

 

Figure E-1 illustrates the energy level transitions in an organic 

molecule in processes of light absorption and emission. 

When light strikes an organic molecule in the ground state, it 

absorbs radiation of certain specific wavelengths to jump to an 

excited state.  A part of the excitation (absorbed) energy is lost 

on vibration relaxation, i.e., radiationless transition to the lowest 

vibrational level takes place in the excited state. 

 

Excitation

Fluorescence/ 
phosphorescenceStable stage 

(Ground state)
Unstable stage 
(Excited state) 

Excited triplet state

3

2

1

Ground state V = 0

PhosphorescenceAbsorption Fluorescence

Light Light

3

2

1

Excited state V = 0

Radiationless 
transition 

Radiationless 
transition 

Excitation light
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And, eventually the molecule returns to the ground state while 

emitting fluorescent radiation.  Also, if radiationless transition to 

the triplet state takes place, then phosphorescence is emitted 

during triplet-to-singlet transition (from the excited triplet state to 

the ground singlet state).  Generally phosphorescence persists 

for 10
-4
 sec or longer due to the selection rule imposed on the 

triplet-to-singlet transition.  In contrast, fluorescence persists for 

a period of 10
-8
 to 10

-9
 sec in most cases. 

 

As mentioned above, part of the radiation absorbed by the 

substance is lost as vibration energy, etc.; therefore, the 

fluorescence wavelength emitted from it is longer than the 

excitation wavelength (Stokes’ law). 

The ratio of the number of photons emitted during fluorescence 

to the number of photons absorbed is called the quantum 

efficiency of fluorescence.  The larger the quantum efficiency a 

substance has, the more fluorescence it emits.  Also, the 

intensity of florescence emitted from a substance is proportional 

to the quantity of light absorbed by it.  When a dilute solution 

sample is measured, the intensity of fluorescence is expressed 

by  

F = KI0clεφ 

where, 

F : Intensity of fluorescence 

K : Instrumental constant 

I0 : Intensity of exciting radiation 

c : Concentration of substance 

l : Cell path length (distance in the cell through which the  

  radiation travels) 

ε : Absorptivity of substance 

φ : Quantum efficiency of substance 
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E.2 Advantages of Fluorometry 

 

As contrasted with fluorometry, absorptiometry for a 

low-concentration sample is explained in the following : 

A sample having 99% transmittance to blank is taken as an 

example.  In the absorbance measurement of such a substance, 

inaccuracies must always be taken into consideration.   

Here, the inaccuracy is assumed to be 0.1%. 

Since it has an effect on both the blank and sample, 

Percent transmittance of blank 100.0 ± 0.1% 

Percent transmittance of sample 99.0 ± 0.1% 

Difference (proportional to 1.0 ± 0.2% 

concentration of sample) 

 

In this example, the uncertainty in concentration measurement is 

±20%.  While in the fluorometry, a difference from zero level 

corresponds to the concentration of sample. 

Accordingly, measurement accuracy is as follows : 

Output signal level at measurement of sample 100 ± 0.1 

Value corresponding to blank 0 ± 0.1 

Difference (proportional to 100 ± 0.2 

concentration of sample) 

 

As can be seen from the above, the fluorometry is very 

advantageous for analyzing a low-concentration sample since its 

uncertainty is in most cases theoretically independent of the 

concentration of sample.  Although actual practice may involve 

some error factors which increase as the concentration of 

sample becomes extremely low, the fluorometry is capable of 

measuring low concentration with an accuracy 100 times higher 

than in absorptiometry. 

Figure E-2 is an explanatory illustration of the foregoing 

description.  In absorptiometry, a difference between the 

quantity of incident radiation Io and the quantity of transmitted 

radiation is represented by signal Is.  A level at which the signal 

Is becomes almost equal to a noise level is used as a detection 

limit.   

In fluorometry, however, since the quantity of fluorescence IF 

itself is represented as a signal, just a small amount of 

fluorescence can be amplified electrically for enabling detection.  

Still more, since a fluorescence wavelength of a substance is 

different from its excitation wavelength (incident light 

wavelength), the fluorescence wavelength is not readily affected 

by the exciting radiation, thereby contributing to ensuring high 

sensitivity.  
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Amplified 

 

Fig. E-2  Comparison between Absorptiometry and Fluorometry 
 

In addition to high sensitivity, fluorometry is advantageous in that 

more information is attainable.  A fluorescence spectrum is also 

available besides an excitation spectrum which corresponds to 

an absorption spectrum in absorptiometry. 

The two kinds of wavelengths can be selected as desired, and a 

fluorescence spectrum can be recorded using a properly 

selected excitation wavelength (or vice versa).  Thus, 

quantitative and qualitative analyses can be made for a sample 

containing plural components. 

Figure E-3 shows a simplified spectral graph of measurement of 

a sample containing multiple components.  In absorptiometry, 

since only the absorption spectrum can be measured, two or 

more component wavelengths are presented.  If the absorption 

wavelengths are similar to each other, each component cannot 

be separated in measurement.  In fluorometry, even if the 

absorption wavelengths are similar, a difference in fluorescence 

makes it possible to select each fluorescence wavelength 

properly.  Thus, each component can be separated in 

measurement. 
 

 

Fig. E-3  Measurement of Mult-Component Sample 

Low 
concentration

High 
concentration

Low 
concentration

(b)  Fluorometry (a)  Absorptiometry

High 
concentration 

Amplified

Absorption spectra 

Component B 

(b)  Fluorometry 

Fluorescence spectra

(a)  Absorptiometry

Component A

Excitation spectra
Component A

Component B



 A -

16

Table E-1 compares information attainable in absorptiometry and 

that in fluorometry. 

 

Table E-1 Comparison of Information Attainable in 

Absorptiometry and Fluorometry 

Absorptiometry Fluorometry 

• Absorption spectrum only 

(Corresponding to excitation 

spectrum in fluorometry) 

• Excitation spectrum 

• Fluorescence spectrum 

 

E.3 Notes of Fluorescence Analysis Measurement 

 

For most kinds of samples, an increase of 1°C in the 

temperature of sample causes the intensity of fluorescence to 

decrease by 1 to 2%.  It is also reported that for some kinds of 

biochemical samples, the intensity of fluorescence decreases as 

much as 10% as the temperature increases by 1°C. 

When analyzing a sample having a temperature-dependent 

property, it is advisable to use the constant-temperature cell 

holder (P/N 650-0150).  Constant-temperature measurement 

can be carried out by circulating constant-temperature water 

through this cell holder. 

 

Some kinds of samples may be susceptible to a chemical 

change due to exciting radiation.  In analysis of such a sample, 

keep the shutter closed to cut off an excitation beam until 

measurement is started, and then open the shutter immediately 

before measurement.  If any chemical change due to exciting 

radiation is observed still, determine a signal level at the start 

time through extrapolation according to variation in signal level. 

 

E.3.1 Temperature 

Dependency of 

Fluorescence 

Intensity 

E.3.2 Chemical 

Change in 

Sample due to 

Radiation 
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In fluorescence measurement, spectra having different natures 

from that of fluorescence may be observed.  These are called 

Rayleigh scattering spectrum and Raman scattering spectra; the 

former appearing at the same wavelength position as the 

excitation spectrum, and the latter appearing at the 

longer-wavelength side near Rayleigh scattering. 

In a fluorescence spectrum, when the excitation wavelength is 

shifted, only the peak height is changed while the peak 

wavelength position remains intact.  In a Raman scattering 

spectrum, when the excitation wavelength is shifted, the peak 

wavelength position is also changed accordingly.  Both the 

Rayleigh scattering and Raman scattering are caused by a 

solvent which may be contained in the sample.   

When examining the spectral plot, be careful not to mistake 

these scattering effects of the fluorescence peak of interest. 

Table E-3 presents the Raman spectral peak position at each 

excitation wavelength for the purpose of reference. 

 

 

Fig. E-4  Raman Spectrum of Water 

E.3.3 Raman 

Scattering 

Relative intensity

Excitation wavelength

Raman scattering
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Table E-3 Raman Peak Positions at Respective Excitation 

Wavelengths 

 

(Excitation 
wavelength) 

Water Ethanol Cyclohexane 
Carbon 

Tetrachloride 
Chloroform 

248 271 267 267                  

313 350 344 344 320 346 

365 416 405 408 375 410 

405 469 459 458 418 461 

Excitation 
wavelength 
and 
Raman 
peak 
position 
(nm) 436 511 500 499 450 502 

 

 

In measurement of a high-concentration sample, a variety of 

error factors may be involved.  The most significant error factor 

consists in that an excitation beam is absorbed at the entrance of 

a cell to prevent a sufficient level of excitation at the center of 

cell. 

Figure E-5 illustrates an extreme case of this condition.   

Although fluorescence is emitted in the vicinity of the entrance 

for the excitation beam, it is not taken into the emission 

monochromator. 

 

 

 

 

 

 

 

 

 

Fig. E-5  Sample Having an Extremely High Concentration 

 

 

E.3.4 Handling of 

High- 

Concentration 

Samples 

Fluorescence is reflected here.

Excitation beam

Fluorescence 
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If only the incident point of excitation beam is bright, it is 

necessary to dilute the sample properly for measurement. 

The second significant error factor consists in extinction due to 

concentration.  This condition is caused by preventing activation 

through interaction of molecules. 

The third significant error factor consists in re-absorption of 

fluorescence.  As shown in Figure E-6, this condition occurs 

due to overlapping between the shot-wavelength side of 

fluorescence spectrum and the long-wavelength side of 

excitation spectrum.  Therefore, it seems that the fluorescence 

spectrum has been shifted toward the long-wavelength side to 

some extent.   

In measurement of an ordinary kind of sample, however, this 

condition will not impede quantitative determination significantly. 

 

 

 

Fig. E-6  Explanatory Illustration of Re-absorption 

 

In any case, if there is a possibility of a measurement error due 

to high concentration of a sample, dilute the sample properly or 

carry out surface fluorescence measurement using a solid 

sample holder. 

 

Wavelength 

Fluorescence spectrum

     Excitation spectrum

Re-absorption occurs here.

 
Relative intensity 
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Where the excitation and emission wavelengths are plotted near 

each other, care should be exercised not to mistake the Raman 

and Rayleigh scattering for the fluorescence spectrum as 

mentioned in E.3.3.  Where the excitation and emission 

wavelengths are plotted apart from each other, care should be 

exercised not to mistake the second-order and third-order 

scattered radiations for the fluorescence spectrum. 

The second-order scattered radiation appears at a wavelength 

two times longer than the excitation wavelength, and the 

third-order scattered radiation occurs at a wavelength three 

times longer. 

For instance, if the excitation wavelength is 240 nm, the 

second-order and third-order radiations take place at 480 and 

720 nm, respectively.  For eliminating these scattered radiations, 

insert a short-wavelength cutoff filter in the path of fluorescing 

radiation (before the emission monochromator).  It is advisable 

to use the filter set (P/N 650-0157) which is available as an 

optional accessory. 

 

Since the fluorescence spectrophotometer provides high 

sensitivity, just a slight amount of contamination on a cell may 

have an adverse effect on results of measurement.  To prevent 

this, treat the cell properly after its use. 

Do not leave the cell containing say sample.  In evaporation of a 

solvent, a residue of sample may adhere to the wall of the cell to 

cause contamination. 

In measurement of a very dilute sample, contamination on the 

inner and outer walls of the cell may cause a problem.  If a 

droplet of sample solution is put on the outer wall of the cell in 

sample injection into it, wipe off the cell with tissue paper and 

then set it on the cell holder. 

 

E.3.5 Second-Order 

Scattered 

Radiation 

E.3.6 Contamination 

of Cell 
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Figure E-7 shows a measurement example of fluorescence 

spectrum. 

 

 

 

 

(1) Scattering of exciting radiation 

(2) Raman spectrum of solvent 

(3) Fluorescence of impurities, solvent, etc. 

(4) Fluorescence of sample 

(5) Second-order spectrum of exciting radiation 

Fig. E-7  Measurement Example of Fluorescence Spectrum 

 

As shown in Figure E-7, other peaks than a fluorescence peak of 

sample appear in fluorescence spectral measurement.   

With reference to this example, it is necessary to identify a 

fluorescence peal of sample. 

 

 

E.3.7 Measurement 

Example of 

Fluorescence 

Spectrum 

(1) 

(5) 
 
(4)

 
(3) 

 
(2) 

Relative intensity

EX EX × 2 Wavelength



 A -

22

APPENDIX F MEASUREMENT OF INSTRUMENTAL 

RESPONSE (CORRECTED SPECTRA) 

 

 

Spectrum correction is performed to enable measuring a true 

spectrum by eliminating instrumental response such as 

wavelength characteristics of the monochromator or detectors.   

The measurement of instrumental response is needed to perform 

spectrum correction.  “Instrumental Response” is the function to 

measure and save the instrumental response.   

 

 

F.1 Measurement of Instrumental Response on Excitation Side 

 

This is the function to obtain the instrumental response on the 

excitation side such as wavelength characteristics of the 

excitation monochromator using Rhodamine B as a standard 

(quantum counter).   

The instrumental response is automatically read with a single 

wavelength scan operation.  A spectrum is correctable within a 

range of 200 to 600 nm.  

 

(1) Handling of Rhodamine B 

 

Pour Rhodamine B into a triangular cell in the procedure 

illustrated in Fig. F-1.  The triangular cell filled with  

Rhodamine B should in principle be stored at a dark place.   

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Fig. F-1  Handling of Rhodamine B 

Syringe F649090 

 

Rhodamine B 

 Cut the supplied 
ampoule of 
Rhoda mine B 
with a cutter.   

Suck the solution 
into a syringe.  

Open the cover 
of triangular cell 
and pour the 
solution into it.  

Fill the cell with the 
solution in a volume 
at least half the 
capacity and close 
the cover.   
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(2) Operating Procedures 

 

(a) Set PMT Voltage to 400 V and Data Mode to 

“Fluorescence”.  Perform “Zero Adjust” to calibrate 

the zero point.   

 

(b) Set the triangular cell filled with Rhodamine B into the 

cell holder in the sample compartment.  (See Fig. 

F-2).   

The triangular cell must be set in the direction shown 

in Fig. F-3. 

 

 

 

 

 

 

 

 

 

 

 

 

Fig. F-2  Setting of Rhodamine B 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Fig. F-3  Setting Direction of Triangular Cell (Top view) 

Excitation light 

Emission 

Triangular cell 

Metal part 

C915758

Triangular cell with metal 
fitting 650 to 1640.   
(filled with Rhodamine B)
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(c) Select “EX” of “Instrumental Response:  Utility”. 

EM wavelength is set at 640 nm and the instrument 

starts EX wavelength scan (from 198.6 nm to  

601.4 nm).   

At this stage, the instrument is automatically set in the 

following conditions.   

 

Slit (EX/EM) ...........5.0/20.0 nm 

Scan speed............60 nm/min 

Scan mode.............Fluorescence 

PMT Voltage ..........400 V 

Response...............Auto 

 

(b) Upon completing the measurement, all of measuring 

conditions are set to those set before.   

Now, instrumental response on the excitation side has 

been measured and stored.  Take out the triangular 

cell filled with Rhodamine B.   
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F.2  Measurement of Instrumental Response on Emission Side 

 

This is the function to obtain the instrumental response on the 

emission side such as wavelength characteristics of the emission 

monochromator and detector (photomultiplier).   

The instrumental response on the emission side is determined by 

measuring a combination of instrumental response on both the 

excitation and emission sides by synchronous wavelength scan, 

and dividing it by the instrumental response on the excitation side 

preliminarily measured.  An emission spectrum is correctable 

within a range of 200 to 600 nm.   

 

(1) Operating Procedures 

 

(a) Set PMT Voltage to 400 V and Data Mode to 

“Fluorescence”.   

Perform “Zero Adjust” to calibrate the zero point.   

 

(b) Set the diffuser into the cell holder in the sample 

compartment.  (See Fig. F-4).   

 

 

 

 

 

 

 

 

 

 

 

 

 

Fig. F-4  Setting of Diffuser 

 

 

NOTE: Measurement of instrumental response on the 

excitation side must be completed before 

executing a measurement of instrumental 

response on the emission side.   

 

 
C915759 

Diffuser 
650-1576 
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(c) Select “EM (200 to 600 nm)” of “Instrumental 

Response:  Utility”.   

EM wavelength is set at 198.6 nm and the instrument 

starts synchronous wavelength scan (from 198.6 nm 

to 601.4 nm).   

At this stage, the instrument is automatically set in the 

following conditions.   

 

Slit (EX/EM) ......... 5.0/20.0 nm 

Scan speed.......... 60 nm/min 

Scan mode .......... Fluorescence 

PMT Voltage........ 400 V 

Response ............ Auto 

 

(d) Upon completing the measurement, all of measuring 

conditions are set to those set before.   

Now, instrumental response on the emission side has 

been measured and stored.  Take out the diffuser.   
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F.3 Measurement of Instrumental Response on the Long Wavelength Range 

of Emission Side (only with Model F-4500) 

 

When a corrected spectrum in the long wavelength area of  

600 nm is required on the emission side, the beam of a lamp for 

which the wavelength characteristics are known is allowed to be 

irradiated to the emission optics, and the instrumental response 

in the long wavelength range on the emission side is read for the 

correction.   

As a light source, a sub standard light source (P/N 250-0124 or 

250-0125) is used.  The correction range by it is 500 to 900 nm 

and, when combined with an instrumental response in the short 

wavelength range, a spectrum correction is available over the 

entire wavelength range (200 to 900 nm) on the emission side.   

 

(1) Mounting and Positioning Sub Standard Light Source 

 

Refer to the instruction manual for the installation of the sub 

standard light source (optional accessory P/N 250-0124 or 

250-0125). 

 

(2) Operating Procedures 

 

(a) Close the cover of the sample compartment.   

 

(b) Set PMT Voltage to 400 V.   

Perform “Zero Adjust” to calibrate the zero point.   

 

(c) Turn ON the power switch of the sub standard light 

source and wait for approx. 5 minutes until the lamp 

stabilizes.   

 

(d) Select “EM (500 to 900 nm)” of “Instrumental 

Response:  Utility”.   

The instrument starts EM wavelength scan (from 

498.6 nm to 901.4 nm).   

At this stage, the instrument is automatically set in the 

following conditions.   

 

Slit (EM)............... 5.0 nm 

Scan speed.......... 60 nm/min 

Scan Mode .......... Luminescence 

PMT Voltage........ 400 V 

Response ............ Auto 
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(e) Upon completing the measurement, all of measuring 

conditions are set to those set before.   

Now, instrumental response on the emission side has 

been measured and stored.  Remove the sub 

standard light source.   
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